What's New in this Release

This version can be upgraded from only IMC PLAT 7.3 (E0605), IMC PLAT 7.3 (E0605H02), IMC PLAT 7.3 (E0605P04), and IMC PLAT 7.3 (E0605H05).

To upgrade from versions prior to V7.3, upgrade both the IMC Platform and all the deployed service components through each released version. The upgrade path is V3.3 >> V5.0 >> V5.1 >> V5.2 >> V7.0 >> V7.1 >> V7.2 >> V7.3. Before you upgrade the IMC Platform, download upgrade packages for all deployed service components from HPE's website, and before you install them pay special attention to the section "Platform Compatibility" in their readme. If an upgrade package is not available for a service component, HPE recommends not upgrading the IMC Platform, or you can remove the service component before upgrading the IMC Platform. When the service component is removed, its data is lost. It is not possible to import the database taken from a previous version into V7.3.
WARNING: Database connection failures might occur during the installation, upgrade, or running of IMC if the Windows operating system on the database server or the domain server to which the database server belongs is updated with any one of the following Microsoft updates:

- KB3172605
- KB3172614
- KB3161608
- KB3161606
- KB3156418

The IMC installation checks were possible for the presence of these Microsoft updates and will warn you to follow the instructions for fixing the issue prior to installing or upgrading your IMC. (The instructions can also be found in the tools\MSKBsC directory in the MSKBsC.zip file). Please follow the instructions carefully. Failure to do so may result in DB errors during and after the installation or upgrade of your IMC.

The following lists all features released in IMC PLAT 7.2 (E0403) and later versions.

**Features released in IMC PLAT 7.3 (E0605P06)**

- The history access logs can be exported.
- The **Physical Network Asset Statistics widget** is added on the homepage.
- The REST API `/perf/topNDData/deviceLevelData` is added to obtain the TopN devices by CPU usage.
- The line thickness can be set for the performance widget in the dashboard.
- The original traps of devices can be stored.
- Devices in the **Unmanaged** state are filtered when devices are automatically backed up.
- Two parameters are added to the configuration file qvdm.conf. One parameter is used to configure the number of background task threads. The other parameter is used to specify whether to use only the TCL script for configuration backup.
- The version of putty in iMC is upgraded from 0.61 to 0.70.
- You can specify a device group for devices automatically discovered during auto discovery.
- The **Location** and **Contact** columns are added for customizing columns for a device view.
- Maintainers can import and export devices.
- The **Reboot Device** task in batch operations can be modified and copied.
- The devices can be filtered by device view in the **Device Asset Report V2** and **Device Asset Report (Concise) V2**.
- For a compliance policy, you can use a formula to configure the relationship between rules as AND or OR. The device view can list compliant interfaces and supports exporting the interface check information. In the strategy view, compliance polices can be filtered based on the policy check results.
- Query conditions **Task Name** and **Creator** are added for deployment tasks.
- The **fault_oid_sour** field was added to the alarm view **nme_fault_v_trap** to represent the original OID information of alarms.
• The **Persisted for** column is added when are alarms are exported in CSV format. The REST API `/fault/alarm` adds a new query condition **Persisted for**.
• The devices can be filtered by custom view on the **CPU Utilization (%)**-**Top5** and **Memory Utilization (%)**-**Top5** widgets on the homepage.
• You can specify different TFTP server addresses for different devices when backing up device configurations.
• The mail sender name can be customized in the alarm mail forwarding configuration.
• Message notifications can be batch enabled and disabled for alarms.

**Features released in IMC PLAT 7.3 (E0605H05)**

• The audit information for the device configuration baselines can be filtered based on the audit result.
• The batch baseline device configuration can be queried based on the time range.

**Features released in IMC PLAT 7.3 (E0605P04)**

• The following columns were added to a user-defined report: serial number, hardware version, software version, and product number on the Report > Custom Reports > Add Custom Report page.
• A RESTful interface was added to modify the device additional information.
• Batch deploying VXLANs, which enables you to create a VXLAN on multiple devices at the same time on the Service > VXLAN Management > Devices page.
• Exporting backup history records on the Service > Configuration Center > Backup History Report > Detailed Information page.
• Merging of CLI scripts and identification and alert for highly risky commands during device configuration deployment on the Service > Configuration Center > Deployment Guide > Deploy Device Configuration page.
• RESTful interfaces used to search for the device configuration, obtain device backup configuration files, back up device software images, and set file transfer protocols were added. The RESTful interface for device configuration was also made open.
• Using configurations that trigger the following types of alarms as the baseline configurations: Running Configuration differs from baseline and Startup Configuration differs from baseline on the Alarm > Alarm Browse > All Alarms > Alarm Details page.
• Exporting device backup configuration files based on device name, IP address, or device model on General Search page.
• Changing the rule for a compliance policy on the Service > Compliance Center > Compliance Policy > Modify Compliance Policy page.
• Multiple levels of thresholds on the Resource > Global Index Settings page.
• Monitoring by group on the Resource > Monitoring Settings Depend On Group page.
• Configuring a platform alarm forwarding rule for APM alarm forwarding on the Alarm > Alarm Settings > Alarm Notification page.
• Changing alarm level settings on the Alarm > Alarm Settings > Alarm Level Configuration page.
• Policy-based alarm level escalation on the Alarm > Alarm Settings > Alarm Level Configuration page.
- Configuring alarm distribution processors by group on the Alarm > Alarms Browse > All Alarms page.
- An option was added to the widget to display the duration or alarm time on the Home Widget.
- Filtering and displaying the syslog list by view ID on the Alarm > Syslog Management > Browse Syslog page.
- Advanced syslog search based on a combination of descriptions on the Alarm > Syslog Management > Browse Syslog page.
- The Performance Index Config tab was moved to the Performance Option menu on the Resource > Performance Option page.
- The RESTful interface for alarm registration was modified. The UUID parameter is now optional.
- The Batch Set button is added for specifying different display indexes for different devices on the Performance Option > Display Index page on the Resource > Performance Option page.
- The software products that already exist in the software library will not be downloaded again from devices.
- During auto discovery, you can specify a device group for auto-discovered devices on the Resource > Auto Discovery page.
- You can filter the check results of check tasks by the check result on the Service > Compliance Center > Task History > Compliance Policy Check Results page.
- You can specify an operator group with the access right when creating a deployment task on the Service > Configuration Center > Deployment Guide > Deploy Device Configuration page.
- The legend cannot be displayed on the CPU Utilization widget.

Features released in IMC PLAT 7.3 (E0605H02)

- None

Features released in IMC PLAT 7.3 (E0605)

- The embedded database was upgraded to SQL Server 2016 Express.
- Support for QoS hardware statistic index (Queue Datagram Hardware Statistics).
- You can start or stop processes on the System > System Configuration > Server page.

Features released in IMC PLAT 7.3 (E0506P09)

- Supports selecting interfaces by port group.
- Supports specifying the port group when an alarm notification rule is added on the Alarm > Alarm Settings > Alarm Notification page.
- Supports viewing the interface status and the status update time in the stack topology on the Resource > Network Topology page.
- Supports synchronously modifying the database administrator password in DBman after the database administrator password is modified on Intelligent Deployment Monitoring Agent.
• Supports filtering devices by model when iCC batch makes device software as the baseline on the Service > Configuration Center > Software Library > Make Baseline page.

• Supports saving the selected device conditions on the realtime alarm widget.

• After you open the VLAN view panel and then click the link for querying port information on the Service > VLAN Management > VLAN Topology page, you can query port information by the combination of VLAN ID, interface type, and device IP.

• Supports disabling the function of using NetBIOS to detect host names on the System > System Configuration > System Settings page.

• Supports customizing SNMP ports on the System > System Configuration > System Settings page.

• Supports customizing Telnet ports on the System > System Configuration > System Settings page.

• Supports monitoring CPU and memory for ZTE devices on the Resource > Performance Management > Monitoring Settings page.

• Supports upgrading patches for Comware devices on the Service > Configuration Center > Deployment Guide > Deploy Device Software page.

• Supports selecting port groups for filtering rules of the up/down trap group on the Alarm > Trap Management > Filtering Trap page.

• Adds the Syslog parameter as the criterion for checking whether alarms escalated from Syslogs are repeated on the Alarm > Trap Management > Trap To Alarm page.

• Whether interface up/down events generate intermittent traps conforms to the interface up/down trap configuration on the Alarm > Trap Management > Filtering Trap > Intermittent Trap Analyze page.

• Adjusts the automatic alarm recovery time to 5:30 am.

Features released in IMC PLAT 7.3 (E0506P07)

• Automatically repairing orphaned users of databases.

• Allowing operators to select to enter the automatic discovery page or the getting started page upon the first login.

• Making the files backed up in one backup task as the baseline on the Service > Configuration Center > Backup History Report page.

• Support of VRM for checking the VRM version and agent version consistency.

• Interface performance monitoring for Brocade switches.

• Specifying the levels of alarms to be reported in hierarchical NMS on the Alarm > Alarm Settings > Hierarchical System Alarming page.

• Monitoring and alarming memory leaks for devices.

• Support for trap definitions of Aruba wireless devices.

• Configuring aggregation times for repeated alarms on the Alarm > Trap Management > Filtering Trap > Duplicate Trap Filter Configuration page.

• Displaying stack physical interface status in the stack topology.

• Trap-based quick synchronization for stack devices.

• DHCP-plug service used to manage DHCP-plugs.

• Software and patch upgrade for H3C Comware 7 devices.

• Distributed database backup and recovery for APM.
• Sorting the list by using the maximum value, minimum value, or average value by clicking the corresponding column heading on the Resource > Performance View > Monitoring Data Statistics page.
• Support for H3C OneStore management.
• After you click the link for one ACL resource and then add or modify one rule set on the Service > ACL Management > ACL Resource page, you can define ACL rules with user-defined rule numbers, and move a rule to the specified position when sorting rules.
• Support Arista devices in VLAN and ACL.

Features released in IMC PLAT 7.3 (E0506P03)

• The speed of opening the device panel improved.
• The DBMan automatic backup recovery function can detect the remaining disk space and trigger an alarm.
• Added support for batch configuration of device type in device view on the Resource > Batch Operation > Configure Device Type page.
• Added support for querying devices by system description on the Advanced Query page.
• Added batch configuration of NETCONF parameters on the Resource > Batch Operation > Netconf Settings page.
• Multiple SNMP parameter templates can be specified for auto discovery in advanced mode.
• Added support for NTP clock monitoring and alarm triggering on H3C network devices.
• Added support for the port display and performance monitoring on Brocade switches.
• Added support for the Inspect function on the Resource > Network Topology > Data Center Topology > System Settings page.
• Added support for inputting the length on the Resource > Network Topology > Data Center Topology page.
• Added support for displaying the history data for the temperature and humidity data on the Resource > Network Topology > Data Center Topology page.
• Added support for adjusting the order of views on the dashboard on the Dashboard page.
• Added the environment and power widget on the Dashboard page.
• Added the environment and power widget on the Homepage.
• Added support for generating a connection between clouds in a topology.
• Added support for custom icons on the topology maps.
• Added support for custom icons on the topology subviews.
• Added support of the topology for the circular layout.
• The topology cloud supports modifying the associated topology.
• The topology supports setting permissions for the hand icon function.
• On an opened VLAN view panel on the topology, the VLAN list is displayed in ascending order of VLAN ID by default.
• Added the configuration template contents of the configuration template library to the general search.
• The report component automatically detects and repairs isolated user problems.
• Sending periodical reports in mails supports retries after a failure.
• Added the HTTPS Access Settings option on the System > System Configuration > HTTPS Access Settings page.
- When you delete a matching rule in the advanced LDAP server configuration of the authentication server configuration, the operator created by the matching rule is deleted synchronously on the System > Operator Management > Authentication Server page.
- Added the Lock Duration for Three Continuous Login Failures option to system parameters.
- Added the Enable Web Proxy option to opening Web-based NMS configuration in system parameters.
- Added the General Configuration Access option to Other SMS Sender on the System > System Configuration > SMSC Settings page.
- Added the REST interfaces related to the deployment monitoring agent.
- Added the REST interface for querying the syslog parsing template library.
- Added the REST interface for querying VLAN devices.
- Added the REST interface for globally querying the members of a VLAN according to the VLAN ID.
- Added the backup configuration file size check. Backup fails if the file size is less than 200 bytes.
- If SSHv2 failed to access some Huawei devices, you can add the device IPs to the server\conf\ssh_v1_devices.cfg file, and use SSHv1 to access the devices.
- The subgroup information is added to the returned information from the REST interface for querying user groups.
- Additional user information is added to the returned information from the REST interface for querying users.
- Support for the IP Routing Table feature was added to the Resource Management module. The feature allows you to view and query the routing tables of managed devices on the Resource > Resource Management > Device Routes page.
- Predefined trap definitions for Aruba devices were added to the Trap Management module.
- The Maintenance Experience field was added on trap definition management pages in the Trap Management module. You can view and edit maintenance experiences for a trap definition.
- The Device Panel is available for ProCurve 2620 devices and HPE 1810 devices.

Features released in IMC PLAT 7.3 (E0506)

- IMC can be installed in SQL Server with the model database smaller than 256M.

Features released in IMC PLAT 7.3 (E0504P04)

- Parameters support * fuzzy matching when you set device severity levels for trap definitions on the Alarm > Trap Management > Trap Definition page.
- Improves the real-time location efficiency on the Resource > Terminal Access > Real-Time Location page.
- Adds the HTTPS access configuration feature, which allows users to upload their own HTTPS certificate files.
- Supports setting the auto layout offset value for nodes in the topology on the Resource > Network Topology page.
- Adds the interface tx/rx rate index on the **Resource > Network Topology > Custom Topology > My Network View > Traffic Topology** page. Adds the function that the traffic topology configuration page is not replaced if you click another button after you click the traffic topology button.
- The **Resource > Performance Management > Performance View** page supports baseline threshold display.
- The **Resource > Performance Management > Global Index Settings** page supports configuring different thresholds based on interface bandwidths.
- The **Resource > Network Topology** page supports link display for Avaya devices.
- The **System > System Settings** page supports setting the CPU, memory, and disk usage thresholds of the IMC server.
- The **Resource > Network Topology** page supports topology baseline comparison.
- The dashboard view supports sorting.
- The rack topology of the 3D room supports setting descriptions of virtual device objects.
- The operator group permission configuration supports setting dashboard permissions.
- The **Resource > Network Topology** page supports changing icons of the topology cloud.
- The **Alarm > Alarm Browse > All Alarms** page supports displaying traffic values of traffic alarms in the performance monitoring in the optimum measurement.
- The **Alarm > Alarm Browse > All Alarms** page supports displaying the alarm sources of blinking alarms.
- Upgrading the OpenSSL version to 1.0.2k.
- Support for specifying devices to be checked by custom views when adding compliance check tasks in iCC.
- Support for importing parameters when deploying configuration to a device in iCC.
- Support for adding match rules based on Group CN on the **Authentication Server > LDAP Server > Advanced Settings** page.

**Features released in IMC PLAT 7.3 (E0504P02)**

- Support for receiving KVM events.
- RESTful interfaces used for querying the lower-level NMS list.
- NETCONF supports UNIS devices.
- RESTful interface: Time-Division Alarm Statistics.
- APM alarms contain the alarm source column that displays the applications and device IP addresses.
- The alarm sources of APM alarms can be redirected to the APM application pages.
- IP column on the All Alarms page.
- Support for accessing the lower-level NMS alarm view through the upper-level NMS by using the URL method.
- Selecting devices for realtime alarms on the IMC home page.
- The alarm statistics feature supports statistics by trap group.
- Periodic test feature for the GSM modem.
- CDMA type for the GSM Modem sending method in the SMSC settings.
- The trap filtering parameter settings support regular expressions.
- RESTful interface: Query Root Alarm Interface.
- Alarm query by alarm time range on the All Alarms page.
- Alarm acknowledgement on the Real-time Alarms page.
- AC traffic monitoring in the VXLAN module.
- The power environment equipments in the 3D room support the i9000 socket data source, including the entrance guard devices, information used for unlocking the control door of the entrance guard system, and the door unlocking operations.
- The map component in the big-screen area of the dashboard supports level-2 drilldown feature.
- The dashboard supports displaying the overall topology.
- The iCC module supports Arista devices.
- After stack member devices are automatically deployed and are stacked, IMC automatically deletes the redundant stack member devices from the system.
- The syslog-to-alarm escalation feature supports the interface alias.
- The trap-to-alarm escalation feature provides the Reduced Scenario mode, which can reduce the number of alarms.
- The trap filtering feature supports matching by regular expression.
- The stack topology supports the Cisco FEX feature.
- Supports configuring auto forwarding recovered alarms to users on the System > System Configuration > System Settings page.

Features released in IMC PLAT 7.3 (E0504)

- None

Features released in IMC PLAT 7.3 (E0503)

- Updates the star theme.
- Changes the page frame to support partial refresh.
- Supports navigating to the AC and AP details pages in resource view.
- Supports displaying AirWave APs in the converged topology.
- IMC can be deployed to VMs created on VMware ESXi Server 6.0.
- The Resource > Device View > Device Details page supports displaying the VDC feature of Cisco devices.
- The Alarm > Alarm Browse > All Alarms page supports merging duplicate alarms into one alarm.
- The Alarm > Alarm Browse > All Alarms page supports viewing child alarms from root alarms.
- The REST API supports querying the IPv6 address of VLAN interfaces.
- The REST API supports obtaining device routing information.
- The Service > Configuration Center page supports configuration backup and recovery for Brocade devices.
- The Service > Configuration Center page supports configuration backup and recovery for ZTE devices.
- The Service > Configuration Center page supports software upgrade for Ruijie 6200 and 2900 series devices.
- The System > System Configuration > Data Collection page supports collecting Layer 2 topology memory information.
• The Resource > Network Topology page supports enabling LLDP for ZTE devices so that IMC can draw the links to the devices.
• The Resource > Device View > Device Details > Interface List page supports interface IP addresses in the VRF of ZTE devices.
• The Resource > Performance Management > Monitoring Settings page supports automatically using the device threshold as the temperature threshold for H3C devices.
• The Alarm > Syslog Management > Syslog Template page supports specifying regular expression for upgrading the alarm rules.
• The Alarm > Syslog Management > Syslog to Alarm page supports modifying the template content for upgrading the alarm rules.
• The HAC license expiration time is consistent with IMC.
• The System > System Configuration > System Settings page supports customizing alarm message format.
• The Alarm > Alarm Browse > All Alarms page displays the alarm source for APM alarms.
• In iMC/server/conf/qvdm.conf, you can customize for how long to save the performance monitoring data.
• The Resource > Network Topology page supports enabling LLDP for the ESXi server so that IMC can draw the links between the switches and the ESXi server.
• When the primary and secondary IMC servers use different versions, DBMan periodically sends alarms.
• The System > System Configuration > Performance Index Configuration page supports dynamic thresholds.
• The DBA privileges are not assigned to IMC users using the Oracle database.
• The Alarm > Alarm Browse > All Alarms page does not generate grouped alarms, unmanaged device alarms, and unknown traps.
• On the System > System Configuration > System Settings page, disabling the DismanPing function deletes NQA configuration from the device.
• The Alarm > Trap Management > Trap Definition page displays trap definition in SNMPv2 format and displays the received original trap OID.
• The export of IMC NMS Trap conforms to the SNMP v2c MIB standard.
• The System > Resource Management > Access Parameter Template page supports duplicate user names in the SNMPv3 template.
• Version update for OpenSSL to 1.0.2h.
• Supports exporting data to an Excel sheet in device view.
• Adds batch undeployment in Intelligent Deployment Monitoring Agent.
• Adds database connection usage information in Intelligent Deployment Monitoring Agent.
• Adds the import/export device appended information function.
• Adds the operator group-related REST API.
• Supports selecting tablespace in Oracle environment.
• Adds performance data to the virtualized topology node tooltip for VRM.
• Adds VM tooltip to the 3D equipment room topology for VRM.
• Adds the device reboot REST API for iCC.
• Adds the REST API for saving the running configuration to the startup configuration for iCC.
• The J# column is added to the Device Asset report (Concise) report, and an entry for inputting J# is provided.
• A report can be sent through email to multiple email addresses. The function of testing whether these destination email addresses are valid is added.
• Custom View Data Summary Report, more advanced device choice on which to report on.
• Supports OneView 3.0 integration.
• Resource management can recognize Arista devices.

**Features released in IMC PLAT 7.2 (E0403P10)**

• The Instance column was added to the Table page accessed by using the Table View mode in the MIB management tool.
• The Alarm > Alarm Settings > Alarm Notification page supports auto sending of recovery alarms.
• On the Alarm > Trap Management page, the Oracle or SQLServer version supports traps with the trap OID not exceeding 500 characters, and the MySQL version supports traps with the trap OID not exceeding 250 characters.
• VRM supports ESX6.0.

**Features released in IMC PLAT 7.2 (E0403L09)**

• Adds support for the HPE Aruba 2930F VSF series on the Resource > Network Topology > Stack Topology page.
• Supports configuring the device synchronization time on the System > Automatic Device Sync Time page.
• Supports Cisco devices whose banners contain the pound signs (#) on the Service > Configuration Center page.
• Supports configuring permitted VLANs for trunk ports of a device that has aggregate interfaces on the Resource > Network Topology > Device > Add to Current VLAN page.
• Supports Cisco Nexus switches on the Service > Configuration Center page.
• Supports displaying interface aliases in performance alarms on the Alarm > Alarm Browse > All Alarms page.
• Supports viewing the CPU and memory recovery alarms of the IMC server on the Alarm > Alarm Browse > All Alarms page.
• Supports configuring whether to escalate alarms for devices with the maintenance tag on the System > System Configuration > System Settings page.
• Supports setting the lifetime for the collected original performance data in the iMC/server/conf/qvdm.conf file.
• Supports configuring whether to send recovery alarms for alarm notifications and forwarding in the iMC/server/conf/qvdm.conf file.
• H3C devices support configuring MACsec links.
• More detailed logs are needed for importing traps through MIB files. For example, the total number of MIB files processed and the total number of MIB files parsed successfully.
• The IMC topology supports displaying and managing server clusters.
• The IMC platform supports customizing the function framework in the UCD by functional point.
• The Real-Time Location page supports adding tags to devices.
• The 3D topology supports selecting the number of switches and the environment & power facility type when you configure environment & power facilities through a right-click.
• The data center topology map supports CAD files.
• Adds the rack height (U) field to the .csv file for the automatical building function of the 3D topology.
• Adds the memory monitoring index for the single device monitor in the IMC dashboard.
• The IMC dashboard supports automatically fitting the custom topology to the screen size.
• The network topology supports setting the font size and color for device labels (the settings take effect only on the current view).
• Adds the loop legend description to the topology.
• The topology link management function supports exporting links to an excel file.
• The elements on the dashboard need the corresponding labels and the object names must be displayed on the labels.

Features released in IMC PLAT 7.2 (E0403P06)

• None

Features released in IMC PLAT 7.2 (E0403P04)

• The Resource > Network Topology page supports the tree layout.
• The Resource > Network Topology > Custom View page provides multiple levels of custom views. This feature implements hierarchical display of custom views in the topology. The hierarchy is consistent with Resource > Custom View and the left navigation tree of the network topology. From this release, all views under the custom view will be displayed hierarchically in the topology according the existing hierarchical relationship.
• The Resource > Network Topology page supports the stack topology of HPE Aruba 5400R series devices.
• The Resource > Network Topology > Data Center page supports monitoring Cointech hygrothermographs.
• The Resource > Network Topology > Data Center page supports recording user operations performed on racks (for example, clicks and browses) and the pauses in the 3D room.
• The 3D room provides RESTful APIs for obtaining rack information and the rack and room locations for a device.
• RESTful APIs for obtaining device MIB tables.
• The Device Detail > Interface List page supports displaying an interface alias that contains more than 64 characters.
• The Service > Network Devices > Device Details page supports adding VXLANs in the EVPN mode.
The Service > VXLNs Traffic Information page provides the VXLAN monitoring feature.

The Service > Network Devices > Device Details page supports configuring ACs.

The Service > Network Devices > Device Details page supports adding L3VNI interfaces in distributed networks.

The Service > Network Devices > Device Details page supports binding VPN instances to DHCP relay IP addresses in distributed networks.

The Service > Network Devices > Device Details page supports adding VSI interface MAC addresses and secondary IP addresses.

Features released in IMC PLAT 7.2 (E0403P03)

- The Dashboard page provides a toolbar on the topology.
- The Dashboard page provides automatic switch between views.
- The Dashboard page supports component-based filtering for widgets to be added.
- The Resource > Network Topology page provides subview alignment in the right-click menu of the topology.
- The Resource > Network Topology page provides the Add Monitor option in the right-click menu of topology links in performance management.
- The Resource > Network Topology page provides the vertical distance configuration between the device icon and the device label.
- The Resource > Network Topology page displays the status of connections in link aggregation by expanding the stack topology.
- The Alarm > Alarm Settings > Alarm Notification page supports the asterisk (*) wildcard character in parameter settings.
- The System > Operator Management > Authentication Server page supports RADIUS server and TACACS server configuration.
- The System > Operator Management > Authentication Server page allows you to define the accessible user groups, device groups, and custom views by OU in advanced settings.
- The Service > Configuration Center page provides software update for Cisco 800, 2651, 2800 series devices.
- The Service > Configuration Center page provides configuration backup and restoration and software update for Aruba 3810 series, 7000 series, and IAP series wireless devices.
- Support for integration with DCN, identifying the VSC and VRS roles, and displaying connection relationships between the roles in the topology.
- VRM supports Windows Hyper-V Server 2012 R2 and SCVMM 2012 R2.
- VRM supports obtaining storage information from VMware hosts.

Features released in IMC PLAT 7.2 (E0403L02)

- Open data sources of iCC for reports, including deployment tasks, backup history reports, device configuration backup, and device software update.
- Backup and restoration of i-Ware configuration on security products.
- Obtaining information about the VMware NTP server, network card speed, and duplex mode in VRM.
- Configuring whether to assign all trunk and hybrid ports to a device VLAN when you add it through the RESTful interface.
- SCOM supports the HTTPS protocol.
- Adding custom templates for performance indexes.
- Displaying custom TopN indexes in the device view, interface view, custom view, IP view, and query result page.
- DBman can back up configuration files that include realtime performance monitoring and traffic topology settings.
- The Lower-Level NMS Performance View widget was added to Dashboard to provide monitoring data of the lower-level NMS.
- The procedure of modifying NMS parameters for devices that failed access parameter verification was added to batch operations.
- The Download Logs feature in Log Configuration supports automatically downloading the software version information.
- Netconf log management in Log Configuration.
- Basic query and advanced query on the operator management page.
- Trap group management was added to the trap management page for trap filtering.
- The Alarm Notification feature supports displaying user information in the destination mail address.
- Using a public IP address as the lower-level NMS address in Hierarchical IMC Alarming settings.
- Using the custom view to filter alarms in Dashboard.
- The Alarm Notification feature supports adding relationships among alarm parameters for alarm configuration.
- Configuring the number of hierarchical alarms to be displayed in Hierarchical IMC Alarming settings.
- Backing up FW, IPS, ACG, and LB data of the H3C i-Ware platform.
- The ACL, VLAN, and iCC features in the Service module support Cisco Nexus series switches.

**Features released in IMC PLAT 7.2 (E0403L01)**

- RESTful API for querying global VLANs.
- Optimized menus in the More and Operation columns in the device list.
- The Deploy Software option was added to the right-click menu of devices on the topology.
- The fabric topology does not display loop links.
- Displaying PE-PE links of IRF fabric devices.
- When unrecovered alarms are not acknowledged option was added to the Alarm Sound Settings page.
- V2 report of unused interfaces.
- Quick service process view.
- Viewers were assigned the privilege of modifying the collection interval on the realtime performance monitoring page.
On the Resource >> Network Topology page, the fabric topology does not display the loop links.
- Modifying ports in the DBMan configuration file.
- DBMan allows you to modify ports in the dbman.conf file in the /dbman/etc directory of the IMC installation path.

Features released in IMC PLAT 7.2 (E0403)

- Supports OneView integration.
- Supports VXLAN.
- Custom views support upper-level views by using the API POST plat/res/view/custom
- Supports the following new operating system: RHEL 7.x.
- Supports Oracle 12c Release 1
- Adding the Perspective QSP template.
- Adding system integration with AirWave
- Integration with Aruba ClearPass and Aruba AirWave trap definitions in trap management of the alarm module.
- Reporting alarms to upper-level IMC administrators for processing when the grace days for alarm acknowledgement expires on the Alarm Notification page of the alarm module.
- The tools directory provides iMC-MIB-Download_Windows.zip or iMC-MIB-Download_Linux.zip to import IMC trap definitions to MIB files
- Set the autocfg_exec_mode parameter to 1 in the file /server/conf/qvdm.conf of the IMC installation path, and then restart the imciccdm program to support serial execution of auto deployment plans.
- Backup function for HPE PROCURE 2520 device configurations on the Service > Configuration Center page.
- Using the device model as the display name in the topology.
- Custom report feature.
- Custom view eAPI and upper-level views.
- Starting and stopping a single process by using command lines in Linux.
- Access to interface lists of interface views by clicking icons on the Interface View TopN widget on the home page.
- Displays route relationships among devices on a route topology based on device routing tables.
- In Intelligent Policy Center, Action Management supports the Restart VM operation.
- On the device query page, the advanced query provides the Device Alarms field.
- On the all alarms page, the advanced query provides the logical combination of NO.
- Supports custom interfaces for third-party mails servers.
- The performance view provides the Modify the Upper-Level Folder feature.
- The configuration template library supports access control by operator group.
- Configuration template deployment supports exporting parameters from CSV files.
- The VRM component supports detecting unmanaged hosts under a managed vManager.
- Device and interface (link) maintenance tagging.
- Displaying or hiding interface aliases in interface-related alarms.
- Sending alarm notification in long SMS messages.
- A Test button is provided to test the SMS modem.
- Scenario-based trap-to-alarm rule configuration.
- Displaying the STP root bridge in the MSTP topology.
- Topology diagnosis.
- Managing Extreme x460 series devices by using Resource Management.
- The default setting for DismanPing is FALSE in the global configuration.
- Configuring a rule to automatically add interfaces of new devices to an interface view.
- Email alarm notifications provide a link for users to confirm the alarms.
- A REST API for obtaining trap definitions is provided.

[Table of Contents]

Problems Fixed in this Release

IMC PLAT 7.3 (E0605P06) fixes the following problems, including all bugs fixed in IMC PLAT 7.2 (E0403) and later versions.

Resolved Problems in IMC PLAT 7.3 (E0605P06)

1. The mails sent are encoded in GBK.
2. The IMC platform has security vulnerabilities PSRT110696, PSRT110724, and PSRT110731.
3. An error occurs on the page when a port aggregation group is added or modified.
4. When configuration is being backed up for some devices, the CPU usage of the imccfgbakdm.exe process reaches 90%.
5. The mails of scheduled reports are sent twice.
6. The configuration backup and restoration function of DBMAN cannot be used if the password for the user named sa is modified in the Windows + separated distributed SQL Server database environment.
7. After the password for the user named sys is modified in the Linux + Oracle environment, the system fails to connect to the database.
8. An operator that has privilege to part of the user groups can view all users on the All Users page.
9. The Device Asset Report V2 fails to be opened if assets with empty names exist.
10. Acknowledging alarms in alarm mails fails.
11. If the configuration to be deployed contains data that do not conform to the specifications of the device, the deployment task is shown as successful, but the configuration fails to be executed on the device.
12. The page for modifying indexes crashes if the threshold level is switched on the page.
13. When you select Other SMS Sender and configure General Configuration Access, SMS messages containing URLs with spaces fail to be sent.
14. When the MIB nodes of a Brocade device do not have interface physical address information, repeated device alarms might be generated.
15. The traffic topology window is not completely displayed and cannot zoom in or out properly.
16. In a distributed environment, the local-address field value in the server-addr.xml file becomes incorrect. As a result, the ITSM and BIMS components cannot work properly.
17. SNMP settings are not imported from .csv file to use with Auto Deployment.
18. IMC fails to upgrade 3600 series switches.
19. IMC Operator unable to log in after update.

Resolved Problems in IMC PLAT 7.3 (E0605H05)

1. The alarm background process is continuously restarted.
2. Unit conversion is not performed for the dynamic threshold curve.
3. An error page opens if you use an operator that does not exist to log in.
4. An error page opens if you click Import Users.
5. An error page opens if you click Batch User Operations.
6. The device append information exported is empty if you export a custom view.
7. The capacity report cannot be properly exported in the .csv format.
8. An error page opens when you click Modify SubGroup Icon for an empty subview.
9. The website certificates are updated.
10. The menu for opening the Web manager is missing on the device view and device details pages.
11. On the All Users page, an operator that has the privilege only to part of the user groups can view all users.

Resolved Problems in IMC PLAT 7.3 (E0605P04)

1. The status of a custom view is incorrect in the topology if the custom view contains multiple levels of subviews.
2. The compressed file downloaded is empty if the subordinate server process logs are downloaded on the Log Configuration page.
3. The exported topology file in visio format cannot be opened if IMC is installed in the Linux environment.
4. The dashboard cannot be displayed correctly.
5. The custom view topology is opened slowly if the custom view contains clouds.
6. The Page display style items configuration change does not take effect on the Configuration Templates page.
7. The page displays only the differences rather than all contents if you switch to Show Difference Only and then switch back to Show All on the Configuration Compare page.
8. The check task related pages are loaded slowly if a large number of check tasks exist.
9. An error page opens when you click Add Display Index if you enter the Display Index page through Auto Discovery > Set Default Monitor Indices > Monitor Option > Display Index.
10. The Traffic Topology does not display data if the same topology is opened on multiple clients and then one of these clients is closed.
11. The page crashes if you select Yes for Allow breaks in performance trend graphs on the Performance Option page.
12. The number of alarms on the alarm panel is different from the actual number of alarms if the following operations are performed: 1) Install the APM component in IMC. APM alarm A exists. 2) Add device B with alarm A to IMC for management. 3) Add the Important Devices widget to the Home page, and add device B to the widget. 4) Alarms are generated on device B.

13. On the Relationship Graph page for Root Alarm Display, the page does not respond when you select View Details or View CI Relationship from the shortcut menu of a device.

14. The number of alarms queried is incorrect in Hierarchical System Alarming.

15. The RESTful interface /imcrs/syslog/log queries data incorrectly.

16. In the converged topology, the cloud positions are not saved if the background of the converged topology is configured as the GIS map.

17. On the 5412 device panel, cards in slot A and slot I are not displayed.

18. A device cannot be added to a rack if virtual devices exist on the rack.

19. The custom topology is opened slowly if the topology has clouds.

20. Auto backup fails if multiple auto backup plans have the same device.

21. The alarm emails are encoded by using GBK.

22. The topology links for Cisco devices are missing if the CDP information of Cisco devices is incorrect.

23. The imcjobmgrdm process crashes if you select a custom view without devices when creating an auto backup plan.


25. The IMC platform components are exposed to security vulnerabilities ZDI-CAN-5749.

26. The IMC platform components are exposed to SLF4J security vulnerabilities CVE-2018-8088.

27. The IMC platform components are exposed to security vulnerabilities PSRT110694.

**Resolved Problems in IMC PLAT 7.3 (E0605H02)**

1. HTTPS access to IMC is denied if the IMC version is upgraded from a version earlier than 7.3.

**Resolved Problems in IMC PLAT 7.3 (E0605)**

1. The card positions are displayed incorrectly on the device panel if IMC PLAT is upgraded from an earlier version to IMC PLAT 7.3 (E0506L08) or later.

2. After related alarms are recovered, the number of alarms on the alarm panel is different from that on the alarm list.

3. In the IMC version leveraging the Oracle database, the trap list is empty.

4. The alarm source is displayed as NMS for APM application alarms if APM application alarms are forwarded through a method (for example, email).

5. Exporting the backup device summary report to a .pdf file failed.

6. The jdk certificate file shipped with IMC is incorrect.

7. In a Window environment, the DHCP Client and Windows Event Log services interfere with javaservice.exe, which might cause IMC upgrade failure.
8. After some Windows updates are installed, the
   TLS_DHE_RSA_WITH_AES_128_CBC_SHA and
   TLS_DHE_RSA_WITH_AES_256_CBC_SHA cipher suites are introduced, which
   might cause IMC upgrade failure.
9. The overlay information of a 6520XE device is slowly synchronized if the 6520XE
   device is fully configured with VSIs and then the VSI information is synchronized to
   IMC.
10. A device is repeatedly added if two operators add the same device to the same rack at the
    same time.
11. The imcjobmgr process restarts unexpectedly when all devices in the auto backup plan
    are deleted from IMC.
12. IMC installation or upgrade fails because of cipher suites.
13. IMC upgrade fails because file javaservice.exe is being used.
14. An error page opens when you display details about the Backup History Report if the
    number of devices in an Auto Backup Plan is greater than 1000.
15. LiveUpdate is unavailable for HPE 5406R zl2 Switch.
16. The auto database recovery succeeds, but a DBMan log message shows that the recovery
    fails because the ZIP file is greater than 2 GB.
17. VPN instances are not available for configuration backup on Cisco IOS devices that do
    not support VPN instances.
18. The system displays an operation timeout error if a user selects the Add VLAN to all
    Trunk and Hybrid ports option when adding VLANs for multiple devices in a topology.
19. The performance page does not respond if IMC has been running for around a week.
20. The imcfaultdm process automatically starts if filtering parameters are specified for a
    single device in an alarm filtering rule in a version earlier than IMC PLAT 7.3
    (E0506P06) and then IMC is upgraded to version IMC PLAT 7.3 (E0506P06) or later.
21. In a HAC scenario, configuration template files cannot be synchronized to standby
    servers.

Resolved Problems in IMC PLAT 7.3 (E0506P09)

1. The iHA client waits for a long period of time before a server group is successfully added
   if the server group is firstly added by the iHA client.
2. The IMC Sync server fails to start if two IMC servers are added to the same group, and
   the active server is switched.
3. The GSM modem test fails if you switch the GSM modem type and test the GSM
   modem.
4. The CPU and memory threshold alarms for the IMC server are inaccurate if the database
   service is started more slowly than the IMC service when the IMC server is restarted.
5. The backup time does not take effect though the system prompts that it is successfully
   modified if the backup time is modified during the DBMan backup process.
6. The global filtering conditions do not take effect if the filtering conditions are separately
   set for a device in the trap filtering rule.
7. The ICC device capability set shows that servers and storage devices are supported.
8. DBMan automatic backup fails and the process is restarted if the backup server is
    unreachable in a DBMan dual-server cold backup scenario.
9. Redundant monitor instances exist for the server storage space usage index monitoring.
10. The alarms on the upper-level IMC are not recovered if the lower-level IMC is configured to report recovered alarms to the upper-level IMC.
11. The IMC server disk space is fully occupied if a large number of core dump files appear on the IMC server in the Linux environment.
12. The alarm page does not respond if the device sends a large number of interface UP/DOWN alarms and the related interfaces do not exist on the device interface list page.
13. "/fault/alarm" On the REST interface, the returned data is incorrect when the data of the last page is queried.
14. "/fault/alarm" On the REST interface, the description of the orderBy parameter is incorrect.
15. "/fault/alarm" On the REST interface, the processing for the desc parameter is incorrect.
16. The IMC platform components are exposed to security vulnerabilities CVE-2018-1835.
17. On an English operating system, an alarm component upgrade might fail.
18. A device software upgrade might fail.
19. When the storage space on a device is greater than 4 GB, a storage space optimization fails.
20. The third parameter in an alarm that notifies the existence of a duplicate device cannot be resolved.
21. Maintainers cannot see a configuration template folder that they themselves created.
22. In the compliance check report, information that is expected to be displayed in a line of the compliance check report is displayed in two or more lines.
23. The LiveUpdate feature cannot upgrade an HPE 3800 or 2920 IRF fabric.

Resolved Problems in IMC PLAT 7.3 (E0506P07)

1. When devices with invalid masks exist, the left resource tree cannot be displayed.
2. If IMC uses the MySQL database, the operation of deleting alarms is slow.
3. A compliance check task for devices in custom views is created. When you view details about the task, the information shows that the task checks all devices.
4. When you create a compliance check task by copying a compliance check task for the devices in a custom view, the operation fails.
5. When you click a search result of General Search, you cannot be navigated to the corresponding device information page.
6. An error occurs if you first set custom view parameters and then set traps when adding a filtering rule on the Alarm > Trap Management > Filtering Trap page.
7. After a compliance check task is executed, the check result column is empty if the compliance check task is created for devices in a custom view.
8. It takes a long time to query history access logs.
9. Access switches cannot be located in real-time VM IP location.
10. The alarm information is inaccurate in the following conditions:
    - The device memory usage gradually increases.
    - Device Memory Trend Alarm is enabled in IMC.
11. The IMC platform components are exposed to security vulnerability CVE-2017-3735.
12. When IMC PLAT 7.3 (E0506) is installed and deployed, processes of the WSM component cannot start.
13. When an interface goes down, an alarm is generated. After the operator enables alarms for disconnected links, the alarm cannot be recovered when the interface comes up.
14. The IMC platform components are exposed to security vulnerability ZDI-CAN-5120.
15. The configuration backup fails on a Nortel BayStack device.
16. An HPE Stack device cannot restart after the software upgrade.
17. After the APM application alarm recovery, the number of alarms on the alarm list is different from the number of alarms on the alarm board.
18. The configuration backup fails on an HPE device.
19. When IMC is installed in a Linux environment, the database backup might fail.
20. The syslog resolution is incorrect when a syslog template with the Use Regular Expression option selected is added.
21. IMC cannot be added with devices that have duplicate IP addresses and interfaces in MIBs.
22. After the related alarms are recovered, the number of alarms on the alarm list is different from the number of alarms on the alarm board.
23. The two interfaces of a link are displayed on the topology, but Idle Interface is displayed for these interfaces on the device interface list page.
24. The device-specific page cannot be opened when the operator queries devices through a general search and then clicks the query result.
25. WSM cannot be upgraded to IMC WSM 7.3 (E0506).
26. The IMC platform components are exposed to security vulnerability ZDI-CAN-5120.
27. The IMC platform components are exposed to security vulnerability CVE-2004-2761.
28. The IMC platform components are exposed to security vulnerability CVE-2017-3735.
29. The IMC platform components are exposed to security vulnerability ZDI-CAN-4067.
30. When IMC is upgraded to IMC PLAT 7.3 (E0506P03), the configuration template folder created by a user is not available.
31. A server error is prompted when the operator performs an SNMP operation in the MIB management window in the following conditions:
   o IMC is deployed with an Oracle database.
   o The operator has cleared the Read-Write Community String field on the device details page. Device Memory Trend Alarm is enabled in IMC.
32. Special characters cannot be used when you modify the username of an SNMP template.
33. When incorrect device SNMP parameters are added, the prompt has spelling errors.
34. After you move a combined subview in the topology, save the topology, and reload the topology, the location of the combined subview might drift if the subview contains a large number of devices.
35. The service monitors cannot be displayed if IMC is upgraded from an earlier version to a version later than IMC PLAT 7.3 (E0504P04).
36. The performance management component fails to be upgraded if the Windows system files are hidden.
37. The operator group privilege cannot be correctly configured for a performance view if an operator in a maintainer group adds the performance view.
38. After you click Performance Index Config on the System page, you cannot enter the performance index configuration page.
39. It takes more than 1 hour for the imcnetresdm process to start when IMC is started.
40. The imcl2topodm process is restarted if the Network Asset Management component is not installed.
41. An HPE stack device fails to be restarted if software is upgraded for the HPE stack device.
42. On the IP/MAC learning query page, the query result is empty for Cisco devices if SNMPv3 is configured to access Cisco devices.
43. The alarm component might fail to be upgraded if IMC PLAT is upgraded from version IMC PLAT 7.3 (E0504) to the patch version of IMC PLAT 7.3 (E0504).
44. The data on the alarm dashboard is incorrect if related alarms are recovered.
45. Configuration backup fails if you back up the configuration for Nortel BayStack devices.
46. An error message appears if the login method SSH and the transfer protocol TFTP are selected for configuring an HPE ProCurve device.
47. Down event alarms are periodically generated for an aggregate subinterface if the aggregate subinterface is down.
48. The link between a server and a switch is not displayed if the server has multiple IP addresses and supports forwarding packets.
49. Failed to log in to an HPE ProCurve 2510G device if SFTP is used to back up the configuration for an HPE ProCurve 2510G device.
50. The alarm statistics are incorrect if application alarms are deleted in APM.
51. The color of an aggregate link in the topology does not change when an aggregate subinterface of the link is down and generates alarms.
52. An error page appears when you delete a trap filtering rule or view the trap filtering rule details.
55. The IMC platform components are exposed to security vulnerabilities ZDI-CAN-4896.

Resolved Problems in IMC PLAT 7.3 (E0506P03)

1. The horizontal axis of the report on the performance view is too dense when the interval between the begin time and the end time is too long.
2. The alarm statistics on the fault board does not match the actual number of alarms when a user deletes devices.
3. IMC upgrade fails when a user has started a deployment task, which causes the imcscliptool and plink processes to be running.
4. Device configuration backup fails by chance.
5. The name of the default SNMP access parameter template can be modified through the REST interface.
6. The alarm statistics on the fault board does not match the actual number of alarms when the APM component is deployed.
7. VRM's REST interface for querying virtual machine information returns data without hard disk information.
8. Importing SNMPv3 devices fails.
9. A device fails to be added through the REST interface when the global SSH template is used.
10. The alarm escalation rule for traps is not updated when a user modifies a self-defined trap and deletes the parameter information.
11. Device synchronization might fail when a user configures the device login mode as Telnet in IMC and synchronizes the device on the ACL device list page.
12. The device information is not updated when a user synchronizes a device after the physical device is replaced.
13. MAC addresses of the Other type are not displayed when a user clicks IP/MAC Learning Query on device details page.
14. The IMC DHCP Plug service might fail to be started when a user restarts the DHCP server.
15. Device software backup might fail when a user backs up device software through TFTP.
16. The displayed device model is incorrect when a user adds an Aruba Stack 2930M device to IMC.
17. The displayed dynamic performance threshold is incorrect when a user adds the device for performance monitoring.
18. The device status changes to Unknown when a user modifies the SNMP parameter to a wrong value on the device details page and synchronizes the device.
19. DBMan fails to recover automatically when the IP address of the subordinate server is configured as a host name.
20. The configuration backup fails when a user backs up the configuration file of a Cisco Catalyst 2924C-XL-V device.
21. A widget has no data when a user adds the TopN widget on the homepage and an unreachable device exists.
22. The device space check timed out when a user upgrades the software for a Cisco stacking device.
23. The alarm fails to recover automatically when IMC receives an auto-recovered alarm.
24. The system prompts "Failed to connect the database server. Please manually input the database file path, which must exist on the database server." when the subordinate server is deployed with only the NTA component and the user clicks Configure on the Environment tab in the intelligent deployment monitoring agent.
25. If the SQL Express embedded database is used, the current database capacity includes the log file size when an alarm appears indicating that the database capacity is close to the upper limit.
26. In an IMC system that contains over 500 PCs, the system prompts a timeout error when some pages are accessed.
27. The imcfaultdm process is restarted if IMC receives alarms reporting interface down events for a link.
28. The imcsyslogdm process is restarted if syslog-to-alarm rules containing regular expressions are configured in IMC.
29. The system displays incorrect dynamic threshold statistics if IMC failed to collect threshold data at certain time points as intended.
30. The device details page of a ZTE device does not contain software version information.
31. The alarm panel displays incorrect alarm statistics if APM alarm sources are added to IMC.
32. The imcnetresdm process failed to start.
33. If the LLDP neighbor information on a port does not match the interface information displayed in IMC, the topology falsely displays two links while actually only one link exists.
34. After the operator configures the Automatic Device Sync Time setting and then restarts the imcnetresdm process, the Automatic Device Sync Time setting does not take effect.
35. An auto backup plan is no longer executed if a database connection error occurs during the execution of the plan.
36. Traps received from SNMP-incapable devices are not displayed on the Browse Trap page.
37. The system failed to back up the configurations of Cisco ASR9001 and ASR9904 devices.
38. The MIB management tool failed to record the complete MIB tree (the specified range of MIB OIDs) as intended if the MIB tree contains invalid MIB OIDs.
39. The Inventory Report contains an empty MAC Address column.
40. The operator cannot log in to IMC by using a password that contains over 15 characters.
41. The password in the SNMP template configured through REST API is displayed in ciphertext.
42. The device information file exported from the device view contains an empty Rack column.
43. The batch operation plan list on the Batch Operation Plan page contains a Modify column but modification for batch operation plans is not supported.
44. The imcfaultdm process might restart if IMC receives traps from devices.
45. A space is appended to the label of the background area of a custom topology each time the operator clicks Save to exit the background editing mode.
46. Denial of service vulnerabilities ZDI-CAN-4808/ZDI-CAN-4809 occur in the MIB management component.
47. Deserialization of untrusted data remote code execution vulnerabilities ZDI-CAN-4759/ZDI-CAN-4760/ZDI-CAN-4761 occur in the NE management component.
49. Remote code execution vulnerability ZDI-CAN-4758 occur in the resource management component.
50. Remote code execution Vulnerability occurs in the DBMAN module.

Resolved Problems in IMC PLAT 7.3 (E0506)

1. When device synchronization is performed on the ACL device page, the imcaclddm process is restarted.
2. If IMC PLAT is upgraded to version 7.3 (E0504), the DBman process fails to start.
3. After the device is replaced with another device with the same IP address, device synchronization fails.
4. If a user configures IMC to send alarms in SMS messages through the modem, SMS message sending fails.
5. If IMC PLAT 7.3 (E0504) is upgraded to any of its patch versions, the alarm component might fail to be upgraded.
6. ACL device synchronization might fail.
7. When a user opens the device panel of a third-party device, right-clicks a port of the device, and selects Interface Management > Port Properties or other items from the shortcut menu, the device details page prompts that the selected port doesn't support this operation.
8. If the ACL application configured on a device is associated with an inexistent ACL definition, a page error occurs when a user synchronizes the device and clicks the Advanced Query button on ACL device page.
9. When a user clicks the VLAN topology link in the navigation bar, selects a topology, and clicks OK, the VLAN topology page does not open.
10. When a user opens the Web manager through the right-click shortcut menu of the device in the topology, a blank page appears.
11. When a user modifies the instance layout for the performance view of the Gather Data type and clicks this performance view, an error occurs.
12. When a user modifies the default monitor indexes for performance and saves the modification, the default monitor indexes are all removed.
13. Auto backup succeeds, but the administrator receives no notification emails.
15. If IMC PLAT is upgraded to version 7.2 (E0403P10), The VLAN Management tab for 3Com switches is lost.
16. When execute actions in sequence is selected as the action execution type in the SCC policy, The execution result of actions displays failure even if the actions are successfully executed.
17. The port status is not displayed when a user views the device panel of some devices.
18. If IMC PLAT is deployed in distributed mode in the Windows environment, IMC PLAT fails to be upgraded to version 7.3 (E0504) on the subordinate hosts.
19. Most IMC processes in the Intelligent Deployment Monitoring Agent might disappear with a low probability if the IMC server is restarted after IMC PLAT is upgraded to version 7.3 (E0504) or its patch version.
20. Some items are not displayed if the number of items on the Remove Baseline page is more than the number of items that can be displayed per page.
21. IMC Plat has addressed multiple remote code execution injection vulnerabilities in this release. These include multiple vulnerabilities in the Java Server Faces (JSF) expression language, directory traversal, denial of service, and deserialization.

Resolved Problems in IMC PLAT 7.3 (E0504P04)

1. The status of ports is incorrectly displayed when you view the HPE 2530-48G or HPE 2530-24G device panel in IMC.
2. The IMC DHCP Plug service fails to be started when the DHCP server or the IMC DHCP Plug service is restarted.
3. Security vulnerability exists if the database is backed up or restored in Intelligent Deployment Monitoring Agent.
4. The links connected to a router are not drawn in the topology.
5. The alarms of a device are not deleted completely 10 minutes after the device is removed from IMC.
6. The status of a task is displayed as Disabled after the auto backup plan runs for a period of time.
7. The H3C Comware V3 stack device configuration file fails to be backed up.
8. The imcupgdm process restarts unexpectedly if H3C Comware V7 software is upgraded and the Set the Current Running Software as Backup Startup Software option is selected.
9. ACL synchronization and deployment fail if ACLs of the name type exist on a Cisco device.
10. Part of the fields of alarms received through SMS or mail notifications are empty if stage forward is enabled for alarm notification rules.
11. The alarm description is different from the contents in the alarm parameters if IMC receives repeated alarms.
12. Some trap definitions with trap OID as 0 exist after IMC PLAT is upgraded to version 7.3.
13. The alarm notification rules do not take effect if stage forward is enabled for them.
14. The recovery time of a recovered trap changes if the system generates self-recovered traps.
15. The imcfaultdm process restarts unexpectedly if you modify the trap definition but do not modify the trap to alarm rule.
16. The Cisco ASR9010 configuration fails to be backed up.
17. When the CMDB CI attribute that contains a back slash (/) is saved and then read, the back slash (/) in the attribute is lost.
18. The Enable Web Proxy option in System Settings is displayed as Chinese characters in IMC in English.
19. The memory usage of the IMC service keeps increasing if IMC PLAT is upgraded to IMC PLAT 7.3 (E0504P02).
20. The expected prompt message does not appear when you enter special characters for the auto layout offset field in the advanced settings for the topology.
21. Only the IP address label is displayed for devices if IMC PLAT 7.3 (E0504P02) is directly installed, multiple labels (including Show IP) are selected for the topology, the configuration is saved, and the topology is reloaded.
22. The legend description for a Loopback-link device is literally inaccurate.
23. After the topology is reloaded, the position of a node in the topology is not the same as that when the topology is saved after the GIS map is configured as the background for the converged topology and the node is dragged to a certain position.
24. The links cannot be viewed conveniently if there are a lot of links after you select Compare with Baseline from the right-click shortcut menu in a blank area in the topology to view the comparison result.
25. The changed items are not prompted or highlighted and cannot be viewed conveniently if you select Compare with Baseline from the right-click shortcut menu in a blank area in the topology to view the comparison result.
26. The ProvinceRegional Map and Flow Center widgets appear when you switch to the platform from the dashboard configuration page.
27. If the administrator assigned views option is selected on the dashboard configuration page and several views are assigned to the group to which the operator belongs, all views are displayed on the same page when the dashboard views are opened.

28. The page crashes if you add a camera to a 3D room, right-click it, and select Data Source Type from the shortcut menu to configure the URL.

29. The rack view page does not respond if you click Modify Area on the rack view page.

30. IMC fails to receive SNMPv3 traps.

31. If a user selects the SNMPv3 template when configuring SNMP parameters for devices, the SNMP parameter test times out.

32. If IMC is upgraded to IMC PLAT 7.3 (E0504), DBMan fails to be started.

33. When a physical device is synchronized after it is replaced, the device asset information in IMC is not updated.

34. HPE1920 device configuration backup fails in IMC.

35. An HPE Aruba 2930M VSF switch is incorrectly identified in IMC.

36. If a greater value is entered when a user modifies the performance threshold, the displayed value is rounded and is different from the entered one.

37. When memory monitoring is added for CheckPoint2600, the performance view displays 100% for the memory usage.

38. When a user adds an operator group, adds an operator to the operator group, and then selects and clears the SNMP, SSH, and Telnet permission of the operator group repeatedly, the parameter template page does not display SNMP, SSH, or Telnet templates.

39. When IMC is upgraded to IMC PLAT 7.3 (E0504P02) and runs for a period of time, the CI list page does not display the CI list.

40. When Syslog data of the same day is queried on the Syslog page, the jserver process crashes.

41. The task name parameter is not parsed and is displayed as $1 on the details page of the trap named Device config is not according to the rules of check task.

42. When the backup directories of the master and subordinate servers are inconsistent and DBMan is used to manually restore the database, database restoration on the subordinate server fails.

43. When the IMC PLAT 7.2 patch version is upgraded to 7.3, DBMan fails to be started.

44. The Service Monitoring page does not display service monitors that are successfully added.

45. The Task History page does not display the View Task Execution Report and View and Get Report links.

46. If IMC is upgraded to IMC PLAT 7.3 (E0504P02), a user is not navigated to the device details page when the user clicks a device label on the custom view page.

47. A user is navigated to the home page each time the user clicks a link in My Favorites.

48. After IMC is started, the login page might display the following message: Failed to load components during the system start up: Component name: iMC-Report.

**Resolved Problems in IMC PLAT 7.3 (E0504P02)**
1. When the route topology feature is enabled and the outgoing interface of the directed route is a loopback interface or MP interface, the IP topology displays a large number of nonexistent links.
2. When all trunk ports (including aggregate interface member ports) are assigned to VLANs, an aggregate interface is disaggregated.
3. When the type of the SNMP template is modified to SNMPv3 Priv-Des Auth-Md5, the SNMP parameter test times out.
4. When the size of the .zip files in the backup data file of the Deployment Monitoring Agent exceeds 2 GB, database restoration fails.
5. The interface bandwidth usage index has no data after a device restart.
6. When IMC is installed in the French language, compliance check tasks cannot be created successfully.
7. When IMC uses the Oracle database, after an operator enters a value in a required field and clicks OK on the page for adding a compliance check task, the page does not respond.
8. When the user is an operator of a custom operator group, custom views cannot be selected when a user creates auto backup tasks.
9. The IMC HAC global configuration is lost after a primary/standby switchover.
10. When IMC PLAT 7.2 (E0403) is upgraded with the P06 patch, a license expiration message is displayed after IMC is started.
11. With the Use Regular Expression option selected for a syslog parsing template, an error occurs when an operator views, modifies, or copies the syslog parsing template.
12. When syslog export is performed, the immediate export has no export time or export data.
13. After an IMC upgrade, an error occurs when an operator views the trap filtering rules that are created before the IMC upgrade.
14. When an operator views the trap definition list and the trap definition details, the trap OID information in the trap definition list is inconsistent with the trap OID information in the trap definition details, and Trap OIDV1 and Trap OIDV2 cannot be displayed.
15. When operators are added and device groups and manageable custom views are customized, privilege errors occur for modules of the IMC platform.
16. When the time range used for data statistics monitoring is switched, a page error occurs.
17. When an operator clicks the global index settings in the performance management module to configure the left navigation settings, the right side of the page is not redirected.
18. On the All Alarms > Advanced Query page, when an operator selects the Alarm Time Range for the Alarm at field, specifies the date and time, and then performs a query, an error occurs.
19. When an operator queries alarms by the time range of 00:00-24:00 or 23:59-24:00, an error occurs.
20. The background alarm process goes down and the System Settings page cannot open if a large number of traps from non-IMC-managed devices are received.
21. IMC is installed in an operating system that uses a comma (,) as a decimal point (for example, a German operating system) and the global threshold for a performance monitoring index contains a decimal fraction. After the threshold is successfully set, the fractional part of the value is displayed as 0s.
22. The configuration of an HPE VC 10Gb module fails to be backed up.
23. IMC auto backup fails if the auto backup time is set to 00:00 in the intelligent deployment monitoring agent.
24. The device configuration backup fails if SFTP is used to back up configuration for an H3C device and the display startup commands shows that the configuration file format is startup.cfg(*).
25. The CPU usage of the IMC server is high in an iHA scenario.
26. If dbman is used to implement auto backup and recovery in an iHA scenario, the master IP address of the standby host is switched to the heartbeat address after the standby host becomes the active host.
27. The background syslog process goes down if Syslogs in incorrect format are sent to IMC.
28. When the software is upgraded for HPE switches, two different software versions are identified as the same if the two software image file names end with letters.
29. Failed to modify NETCONF parameters for devices.
30. On the page for adding or modifying a configuration template, the non-default operator groups are not displayed.
32. In the device details for 5130EI series devices, the device management menu does not have the RADIUS Server Configuration and Interface 802.1X Configuration items.
33. After upgrading to IMC PLAT 7.3 (E0504), it's failed to synchronize the device with SNMP V3.

Resolved Problems in IMC PLAT 7.3 (E0504)

1. None

Resolved Problems in IMC PLAT 7.3 (E0503)

1. When more than 246 KB update packages are installed on the IMC server running Windows, the sysinfo tool fails to collect information about all KB update packages.
2. The report module has the security vulnerability of apache commons CVE-2016-4372.
3. When a large number of custom views exist, the Select Device page is slow to load on the resource homepage and all of the alarm pages.
4. The CPU usage is high in the HAC environment.
5. DBMan fails to recover from a backup file if the .zip file backed up by using DBMan exceeds 2G.
6. The configuration file backed up by iCC has incorrect contents if the echo display contains the greater than signs (>) when you log in to an HPE device.
7. IMC prompts the device software fails to be upgraded if the software upgrade process has been running for more than 1 hour for Cisco stack devices.
8. IMC fails to be upgraded from 7.2 to 7.3 if you try to upgrade IMC from 7.2 to 7.3 in an environment using the Thai language.
9. If the HPE Procurve device deploys startup configuration through SFTP, the deployment fails.
10. If the Cisco device deploys startup configuration through SCP, the deployment fails.
11. If the H3C Comware V7 device attempts to recover the device software, a timeout message is displayed.
12. If performance monitor is added in the MySQL environment, the performance monitoring data is unavailable occasionally.
13. The plat module has the security vulnerability of SQL Server CVE-2015-1761.

Resolved Problems in IMC PLAT 7.2 (E0403P10)

1. When an operator modifies an ACL in IMC, the ACL rule numbers of the ACL change.
2. When an operator modifies an ACL in IMC, the ACL name of the ACL is deleted.
3. When a larger number of syslog to alarm rules are configured and the rules contain views, upgrading syslogs to alarms takes a long time.
4. When staged alarm notification is configured, the recipients of recovery alarms are not identical to the recipients of alarms.
5. When multiple devices are selected to execute access parameters checking, an error occurs when accessing the IMC home page and the log information indicates that the system is busy.
6. When no data is returned during the interaction of some GSM modems, SMS message test fails.
7. If the Telnet service is disabled on HPE ProCurve devices, configuration backup fails.
8. When alarms are forwarded through SMS messages, the SMS messages support including alarm generation time.
9. An operator fails to access the operator page after clicking Add Operator or Modify Operator.
10. The expiration date of the VXLAN module is not identical to the expiration date of the IMC platform on the About page.
11. An operator fails to access the next page when the number of performance views exceeds the selected maximum display number of 50. When the maximum display number is set to 8, no page navigation icons are displayed.
12. IMC server throws Java exception when trying to TEST SNMP parameters in Batch operations SSH settings page.
13. Deprecate the REST interface /imcrs/vrm/host/templete for VRM.
14. After Java 8 is installed, a dialog box displaying "Block potentially unsafe components from being run" appears when you click SSH on device Action list.

Resolved Problems in IMC PLAT 7.2 (E0403L09)

1. The device software library does not display the HPE 5900AF-5920AF_7.10.R2418P06-B software downloaded from LiveUpdate.
2. The AP monitoring data becomes abnormal when the AP is rebooted.
3. Failure to back up the configuration for HPE PROCURVE 26/28 series devices.
4. The VRM plugin cannot work properly because there is a line feed between the IP address and the port number in the VRM plugin configuration file.
5. On the IMC operator group management page, the Access Lower-Level NMS privilege (the privilege is added by default) is added to the viewer group to control the viewers' access to the snapshot of lower-level NMS view on the IMC resource page.
6. The IP addresses of online accounts are not correct on the access log history page.
7. You will receive the same Email twice if you configure two email addresses on the alarm notification page.
8. The system fails to upgrade the IMC inventory component when other database users are used.
9. After debugging is enabled, the IMC web page is unusable.
10. When you click Add or Modify on the System > Operators page, the page might hang or be busy.
11. If a transceiver module is plugged or unplugged, the transceiver module change is not displayed after the asset synchronization interval.

Resolved Problems in IMC PLAT 7.2 (E0403P06)

1. When two cloud views point to each other's parent custom view, page errors occur.
2. VRM does not support Windows Server 2012 R2.
3. When an operator logs in to the backup IMC of an IMC system that has the primary and backup IMC licenses registered, the following message appears: Invalid license.
4. The statuses of subviews of a custom view are not counted in determining the status of the custom view.
5. The widgets on the dashboard cannot be refreshed.
6. Sometimes the mail sending feature for auto backup plans is unavailable and users cannot receive mails.

Resolved Problems in IMC PLAT 7.2 (E0403P04)

1. When device synchronization is performed for multiple times, database access errors occur.
2. After Syslog events are occurred for a monitor index, an operator increases the threshold and reduces the repeat times value to be smaller than the occurrence times. Then, the performance module reports alarms even when the threshold is not exceeded.
3. Devices cannot be added to IMC by using SNMPv3 templates.
4. If IMC polls immediately after devices are restarted, the year in the generation time of interface down alarms might be 1970.
5. When IMC is upgraded to IMC PLAT 7.2 (E0403), IMC PLAT 7.2 (E0403L01), IMC PLAT 7.2 (E0403L02), or IMC PLAT 7.2 (E0403P03), alarm forwarding mails does not support the plaintext format.
6. When an operator attempts to delete a custom trap filter rule, a "system busy" message appears.
7. When an MP link recovers from the down state, the status of the MP link is not displayed correctly.
8. When services do not respond for a short time, service down alarms are generated in service monitoring.
9. VXLAN traffic information is generated based only on a single index.
10. Licenses for the IMC platform do not include the VXLAN license.
11. The ACL device list does not display HPE OEM devices of the H3C brand.
12. Aggregate interfaces cannot be added for devices running Comware 7.
13. When IMC is upgraded from versions earlier than IMC PLAT 5.1 (E0202) to IMC PLAT 7.2 (E0403L02) or IMC PLAT 7.2 (E0403P03), the Access Parameter Template page might display SNMP, Telnet, or SSH parameters as SNMP, Telnet, or SSH templates. 
14. On the MSTI list page, VLANs mapped to MSTIs are incorrect for HPE devices.

Resolved Problems in IMC PLAT 7.2 (E0403P03)

1. When the custom view contains multiple levels of cloud views in the custom topology, the status of a custom view or cloud view is incorrect in a custom topology.
3. When the alarm matches two mail notification rules, an alarm mail is sent twice.
4. When idle interfaces are used as an interface filter criterion in port group view, subinterfaces of an aggregated link are displayed.

Resolved Problems in IMC PLAT 7.2 (E0403L02)

1. When the WSM component is deployed, an operator can successfully change the theme of a dashboard through the theme menu, but the theme menu displays each theme name as undefined.
2. The operator can successfully delete a report on the My Reports page but fails to delete another report without refreshing the page.
3. When an operator logs in to IMC as a maintainer or viewer and attempts to access the realtime performance monitoring page, a page error occurs.
4. When a large number of performance monitor instances exist on a device, the At a Glance page of the device is loading and cannot display data.
5. When an operator logs in to the standard platform of IMC, the Resource tab does not display the Maintenance Task option.
6. When the screen resolution is set to 1280 and the IMC Web page theme is set to ash black, the basic management view page displays contents in the navigation bar at the top of the page in separate lines.
7. When an operator accesses the System Settings page, the System Settings page does not display the Task History Lifetime field.
8. When the alarm module is deployed, the tip information of each device in racks in the 3D room does not contain the alarm information.
9. The software products downloaded from LiveUpdate cannot be displayed in the software library of iCC.
10. The resource background fails to be started if you install SSM, create a virtual firewall, delete the firewall, and then restart the resource background.
11. A Syslog of more than 1024 bytes cannot be displayed correctly in IMC.
12. After an AP is rebooted, traffic statistics for the AP are displayed incorrectly.
13. If an alarm matches two rules in the alarm notification settings, alarm notification mails are repeatedly received for the alarm.
14. When a new rule is to be added to a compliance policy, in the device series selection window, the selected entries are cleared after entries are paged forward or backward.
Resolved Problems in IMC PLAT 7.2 (E0403L01)

1. VLAN topologies are inaccessible in QSP view.
2. When a virtual machine on a host is cloned, the system displays a page for fixing the 
   operation failure.
3. In QSP view, menus under Deploying Firmware are incorrect.
4. Customized columns on the network asset page are not displayed when the operator who 
   customized them relogs in to IMC.
5. When interfaces on Comware devices are bound with VPN instances, the interface list for 
   Comware devices does not display interface address information.
6. When a member port of an aggregate interface comes up again, the interface-down alarm 
   for the port is not recovered.
7. IMC cannot display the CPU usage of each processor for a Linux server that has multiple 
   processors.
8. Alarms sometimes are not triggered for services monitored on the Device Details page.
9. Direct link status does not change when the interface status in the route topology is 
   changed.
10. When a new sFlow probe instance is added for a device, existing instances for sFlow 
    probes are overridden.
11. VMs cannot be deleted from a host that runs CAS.
12. The sending time in SMS message delivery records is in 12-hour format for SMS 
    messages delivered through the IMC SMS sender, third-party SMS sender, or mail-to- 
    SMS conversion function.
13. In the RSM edition, the page crashes when an interface view is added.
14. Security holes #576313: Security holes exist when Apache Commons Collections Java 
    library insecurely deserializes data.
15. Query criteria are invalid in the alarm query view after the IMC PLAT is upgraded to a 
    version later than IMC PLAT 7.1 (E0303P13).
16. An error page appears when the parameter setting page of the custom report function is 
    opened in a service component.
17. On the custom topology, device labels are modified to Korean character strings, and they 
    become illegible after the topology is reloaded.
18. Device alarm event configuration entries cannot be added.
19. Lower-level IMC does not have the left navigation tree when it is accessed from the 
    upper-level IMC system.

Resolved Problems in IMC PLAT 7.2 (E0403)

1. This symptom occurs when a user views the dashboard that contains the per-level alarm 
   trend chart. The dashboard displays data incorrectly.
2. This symptom occurs when a user adds the per-level alarm trend chart (the alarm class is 
   all alarms) and the per-class statistics trend chart (the alarm class is configuration alarms) 
   to the dashboard and monitors alarms for some time. Curves of the per-level alarm trend 
   chart fall at irregular intervals.
3. This symptom occurs when a user selects a device on the Applet network topology, right-clicks the device, and then selects Open Device Panel from the shortcut menu. A page error occurs when a user accesses the device panel.

4. This symptom occurs when Enable Mail Notification is selected in license expiration mail notification settings on the system settings page. The mail content is incorrect and the mail format requires optimization.

5. This symptom occurs when a user access the system settings page with the alarm module not installed. Accessing the system settings page takes a long time.

6. This symptom occurs when a user clicks Add Link on the link management page for a custom topology. An error for the Add Link page occurs.

7. This symptom occurs when a maintainer logs in to IMC and double-clicks a cloud in the converged topology. A maintainer fails to open the topology for a cloud.

8. This symptom occurs when a user clicks Add Link icon on the converged topology, or right-clicks the converged topology and selects Add Link from the shortcut menu. An error for the Link Management page occurs.

9. This symptom occurs when a user clicks Save in the toolbar on the converged topology. The note and the background area cannot be saved.

10. This symptom occurs when a user accesses a REST API. The associated model schema for a REST API does not exist.

11. This symptom occurs after the WSM component is installed. The REST APIs of the license management are unavailable and the response codes are 404.

12. This symptom occurs when a maintainer who has no management rights to self-service accounts modifies a user. A page error occurs when a maintainer attempts to modify a user.

13. This symptom occurs when IMC had ever been started before it was upgraded to IMC PLAT 7.1 (E0303P13). The Device Asset Report(Concise) cannot be obtained after IMC was upgraded to IMC PLAT 7.1 (E0303P13).

14. This symptom occurs when a user exports the Device Asset Report(Concise). The summary report at the end of the Device Asset Report(Concise) is displayed incorrectly after the Device Asset Report(Concise) is exported to an EXCEL file.

15. This symptom occurs when the performance management module is installed and monitoring objects are added in IMC that runs in Linux and uses an Oracle database. The performance background process restarts sometimes.

16. This symptom occurs when a user deploys the alarm management module of the IMC PLAT 7.1 (E0303P13) version, undeploys and removes the module, and then deploys the module again. An error occurs during the deployment of the alarm management module of the IMC PLAT 7.1 (E0303P13) version.

17. This symptom occurs when the sending alarm SMS message feature is enabled in IMC that runs in Linux. Alarm SMS messages cannot be received.

18. IMC runs on Linux and uses the Oracle database. An error page appears after an operator clicks Refresh on the server details page that contains an empty server name field.

19. The disk space of the IMC server is full after DBMan automatic backup runs for a long period of time in distributed, standalone, or primary/backup IMC deployment.

20. An operator disables the route topology feature and then synchronizes devices. The custom topology still contains links added by the route topology feature.
21. The topology page displays an incorrect link state after an operator performs the following procedure:
   a. On the topology page, changes the link interface for a device whose state has changed from reachable to unreachable.
   b. Views the link status.
22. The SNMP parameters test displays a Failure message after an operator performs the following procedure:
   a. Clicks MIB Management in the Action section of a device's Device Details page, and then opens the SNMP parameter configuration page.
   b. Configures the read-only community string in the Read-Only Community String field, and leaves the Read-Write Community String field empty.
   c. Clicks Test.
23. An operator configures an SMS messaging alarm notification rule with a plus sign (+) preceding the country code. The cellphone cannot receive alarm notification SMS messages.
24. The following error message appears after an operator deletes a trap definition from the trap definition list:
   Operation failed with error code 4002. Please contact your administrator.
25. An error page appears after an operator configures the alarm reporting feature for the first time on the hierarchical IMC alarming configuration page.
26. When an operator modifies index settings on the Add Monitor page and attempts to select the Global Index Settings option, a page error appears.
27. Monitor data loss occurs on the realtime performance monitoring page after a performance management module upgrade.
28. SMS messages cannot be sent by using the Convert Mail into SMS sending method after the reboot of IMC.
29. When a single mail notification rule on the Alarm Notification page contains more than one recipient address, sending of alarm notification mails fails.
30. A page error might occur when an operator clicks the ACL Configuration icon for a device on the ACL device list page of the ACL management module.
31. If a .csv file contains SNMPv3 parameters, it cannot be imported to auto deployment plans.
32. When the report module is deployed after the IMC platform with a remote database is upgraded to IMC PLAT 7.2 (E0403), the following message appears: Invalid object name 'TBL_RPTVIEWER_INSTALL_UPDATE'.
33. Database files backed up by running DBMan commands cannot be restored through DBMan.
34. After a device that includes aggregation interfaces is added to IMC, the VLAN device list does not display the device.
35. When the log level of the alarm module is set to Debug, CoreDump sometimes occurs in the background process of the alarm module.
36. If an online endpoint uses an IP address different than the endpoint IP/MAC address binding in the terminal access module, IMC generates IP/MAC address inconsistency alarms for the endpoint multiple times.

38. All configuration template files in iCC will be cleared if you update an early version to IMC PLAT 7.1 (E0303P16) or later.

IMC Software Distribution Contents

The IMC PLAT 7.3 (E0605P04) distribution list contains the following files and folders:

1. manual\readme_plat_7.3 (E0605P04).html - This file
2. windows\install - IMC installation program
3. linux\install - IMC installation program for Red Hat Enterprise Linux

Installation Prerequisites

Server Requirements

The following are the minimum hardware requirements and supported software programs to run IMC platform, for additional resource requirements please check IMC components’ readmes:

- Minimum hardware requirements
  - Pentium 4 3.0 GHz processor
  - 8 GB of RAM
  - 100 GB hard disk space

- Operating system:
  - Windows Server 2008 X64 with Service Pack 2
  - Windows Server 2008 R2 X64 with Service Pack 1
  - Windows Server 2012 X64 with KB2836988
  - Windows Server 2012 R2 X64
  - Windows Server 2016 R1 X64
  - Red Hat Enterprise Linux 5.5 X64 (Enterprise and Standard versions only)
- Red Hat Enterprise Linux 5.9 X64 (Enterprise and Standard versions only)
- Red Hat Enterprise Linux 6.x X64 (Enterprise and Standard versions only)
- Red Hat Enterprise Linux 7.x X64 (Enterprise and Standard versions only)

- VMware:
  - VMware Workstation 6.5.x
  - VMware Workstation 9.0.x
  - VMware ESXi Server 4.x
  - VMware ESXi Server 5.x
  - VMware ESXi Server 6.0
  - VMware ESXi Server 6.5

- Hyper-V:
  - Windows Server 2008 R2 Hyper-V
  - Windows Server 2012 Hyper-V
  - Windows Server 2016 Hyper-V

- Database
  - Microsoft SQL Server 2008 Enterprise Service Pack 3 (Windows only)
  - Microsoft SQL Server 2008 R2 Enterprise Service Pack 2 (Windows only)
  - Microsoft SQL Server 2012 Enterprise Service Pack 3 (Windows only)
  - Microsoft SQL Server 2014 Enterprise (Windows only)
  - Microsoft SQL Server 2014 SP2 Enterprise (Windows only)
  - Microsoft SQL Server 2016 Enterprise (Windows only)
  - Microsoft SQL Server 2016 SP1 Enterprise (Windows only)
  - Microsoft SQL Server 2016 Standard (Windows only, Up to 1000 devices are supported)
  - Microsoft SQL Server 2016 SP1 Standard (Windows only, Up to 1000 devices are supported)
  - Microsoft SQL Server 2016 SP2
  - Oracle 11g Release 1 (Linux only)
  - Oracle 11g Release 2 (Linux only)
  - Oracle 12c Release 1 (Linux only)
- MySQL Enterprise Server 5.5 (Linux and Windows) (Up to 1000 devices are supported)
- MySQL Enterprise Server 5.6 (Linux and Windows) (Up to 1000 devices are supported)
- MySQL Enterprise Server 5.7 (Linux and Windows) (Up to 1000 devices are supported)

Note: 64-bit operating systems are recommended over 32-bit operating systems because of the larger amount of available memory for applications.

Note: Optimal hardware requirements vary with scale, other management factors, and are specific to each infrastructure. Please consult HPE, or your local account teams and precise requirements can be provided.

Note: If an embedded database is used, you must install the .net framework 4.6. The .net framework 4.7 is not supported.

GSM modem (optional)

A GSM modem is required for forwarding alarm messages. The following models have been tested to work with IMC. For more information about a specific GSM modem, see its product manual.

- WaveCom M2306B
- WaveCom TS-WGC1 (Q2403A)
- Wanxiang serial port GSM modem (DG-C1A)
- Wanxiang USB GSM modem (DG-U1A)
- Wanxiang USB min GSM modem (DG-MINI)
- WaveCom M1206B GSM modem (chip: 24PL)
- WaveCom USB M1206B GSM modem (chip: Q24PL, Q2403A)

[ Table of Contents ]

---

**Client Prerequisites**

**PC Requirements**

- Minimum hardware requirements
  - 2.0 GHz processor
  - 4096 MB of RAM
  - 50 GB hard disk space
• Operating system
  o Windows XP SP3 or later (except the tablet mode and touch mode)

• Browser
  o IE 10 or 11 is recommended.
  o Firefox 50 or later is recommended.
  o Chrome 64 or later is recommended.
  o Turn off the pop-up blocking settings in the browser.
  o Add the IMC website to the trusted sites of the browser.
  o The recommended resolution width is 1280.
  o JRE 1.7.0_update76 or later is recommended. If a client has no JRE, IMC prompts the user to install JRE for the client.

[ Table of Contents ]

---

**Installing and Upgrading IMC**


1. Open the Control Panel from the Start menu and click **System and Security**.
2. In the **Action Center**, click the **Change User Account Control Settings** link.
3. In the **User Account Control Settings** window, set the Choose when to be notified about changes to your computer to Never notify.

To upgrade IMC:

1. Back up the IMC database on the **Environment** tab in the Deployment Monitoring Agent.
2. Manually copy the IMC installation directory to a backup path.
3. Stop IMC in the Deployment Monitoring Agent.
4. Click **Install** on the **Monitor** tab of the Deployment Monitoring Agent.
5. Select the windows/install/components directory in the upgrade package and click **OK**.
6. Click **OK** in the popup message dialog box.
7. Click **Start** in the **Upgrade Common Components** dialog box to upgrade common components.
8. After common components are upgraded, click **Close**.
9. In distributed deployment mode, stop the Deployment Monitoring Agent on the master server and restart the Deployment Monitoring Agent on every subordinate server. Click
Yes in the popup message dialog box to upgrade common components on every subordinate server.

10. The Deployment Monitoring Agent displays all components that need to be upgraded. Click OK to start upgrading.

11. In distributed deployment mode, upgrade all components deployed on every subordinate server.

12. After all components are updated, start all processes in the Deployment Monitoring Agent.

For more information about installation and upgrade procedures, see *IMC Getting Started Guide* and IMC deployment guides.

**Important:**

1. Before you upgrade the IMC Platform, download upgrade packages for all deployed service components from HPE's website, and before you install them pay special attention to the section "Platform Compatibility" in their readme. If an upgrade package is not available for a service component, HPE recommends not upgrading the IMC Platform, or you can remove the service component before upgrading the IMC Platform. When the service component is removed, its data is lost.

2. If the Deployment Monitoring Agent displays a list of components incompatible with the new version of the IMC Platform, you must download upgrade packages for these components before you can continue the upgrade process.

3. All service components must use v7.2 or higher to work with IMC PLAT 7.2. After the IMC Platform is upgraded, upgrade the deployed service components, such as WSM, UAM, EAD, NTA/UBA, APM, and SOM. Before installing or upgrading a service component on this platform software, please verify the section "Platform Compatibility" in the service component's readme. Otherwise, IMC might not be started. For the compatibility matrix, see readme files of the service components.

4. If you receive the message "Upgrade JVM failed..." during the upgrade process, restart server and delete the folder in the common\jre directory of the IMC installation path and continue to upgrade.

5. For data integrity, HPE recommends backing up database on the Environment tab of the Deployment Monitoring Agent, and copying the IMC installation directory to a secure location after the upgrade.

[ Table of Contents ]

---

**Removing IMC**

To remove IMC on Windows, run the uninstallation wizard by selecting **All Programs > Intelligent Management Center > Uninstall IMC** from the Start menu, or you can remove the Intelligent Management Center in the **Add or Remove Programs** window of the Control Panel.
To remove IMC on Linux, enter the `deploy` directory of the IMC installation path by using the `cd` command, and then execute `uninstall.sh`. IMC is typically installed in the `/opt/iMC` directory.

Follow the directions in the uninstallation wizard, and manually delete all files in the IMC directory when the process is complete.

---

Running the Deployment Monitoring Agent

The Deployment Monitoring Agent is a GUI program to manage the deployment of the IMC modules and monitor the performance and the state of processes of the IMC server. After the installation finished, the Deployment Monitoring Agent is automatically started to guide the user through deployment.

On Windows, run the Deployment Monitoring Agent by selecting `All Programs > Intelligent Management Center > Deployment Monitoring Agent` from the Start menu. On Linux, run the Deployment Monitoring Agent by executing `dma.sh` in the `deploy` directory of the IMC installation path.

If Deployment Monitoring Agent cannot start, make sure the HPE IMC Server service is running. This service is automatically started along with the OS and runs as a daemon/background process. On Windows, you can start the service in Windows Services. On Linux, you can start the service with the `service imcdmsd start` command.

IMC must be started from the Deployment Monitoring Agent.

---

Starting IMC

To start IMC, click `Start IMC` on the Monitor tab of the Deployment Monitoring Agent.

---

Logging in to IMC through a Web Browser
Once the server is running, you can access the IMC user interface using a Web browser. Enter the following address in the Address Bar of a browser:

http://hostname:port/imc

Where hostname is the host name or IP address of the IMC server (the default is localhost if you launch the Web browser on the IMC server machine), and port is the Web server port (the default is 8080) used by IMC.

You can also access the IMC user interface with Web browser through HTTPS. Enter the following address in the address bar of a browser:

https://hostname:port/imc

Where hostname is the host name or IP address of the IMC server (the default is localhost if you launch the Web browser on the IMC server machine), and port is the Web server port for HTTPS (the default is 8443) used by IMC.

When the IMC login page appears, use the username "admin" and password "admin" to log into IMC.

Refer to the IMC Online Help for details on how to add operators, and add your devices to IMC.

The default security level in the IE properties is High. If you try to log in to IMC with this default, the system will prompt "Content from the Web site listed below is being blocked by the Internet Explorer Enhanced Security Configuration." Click Add to add the IMC website to the trusted sites. If you do not add the IMC website to the trusted sites and determine not to display the prompt any more, you may fail to log in to IMC. To solve the problem, use either of the following methods:

1. Set the security level to Medium.
   - Start IE and select Tools > Internet Options.
   - Select the Security tab, and then click Custom Level.
   - In the popup dialog box, set the security level to Medium.
2. Add the website of the IMC server to the trusted sites.
   - Start IE and select Tools > Internet Options.
   - Select the Security tab, Select Trusted sites, and the click Sites.
   - Add the website of the IMC server in the popup dialog box.

On your first access to Resource > Network Topology, the browser prompts "The application's digital signature cannot be verified. Do you want to run the application?" Below the prompt are the name "topo", and the publisher "IMC Development Team". Select the "Always trust content from this publisher" checkbox, and click Run.

**Note:** In centralized deployment, when the "User Access Manager - User SelfService" component is deployed, you will enter the Self-Service login page rather than the IMC login page if you enter http://hostname:port/ in the address bar. To enter the IMC login page, change the
**Monitoring the Server**

On the Monitor tab of the Deployment Monitoring Agent, you can see the Disk Usage, CPU Usage, and Physical Memory Usage of the IMC server. On the Process tab of the Deployment Monitoring Agent, you can see all IMC processes and their running status. On the Environment tab of the Deployment Monitoring Agent, you can see the OS information and database usage.

You can see the monitoring data of the IMC server only when IMC is started. For information about starting IMC, see "Starting IMC".

**Distributed Deployment**

The IMC components can be installed on more than one server to meet specific performance requirements. A distributed IMC system typically has one master server with IMC Platform deployed and multiple subordinate servers with service components deployed.

To install IMC on a subordinate server, execute the installslave.bat file on Windows (or installslave.sh on Linux) by either double-clicking the file or running the command in the folder where installslave.bat (or installslave.sh) is located.

For information about deploying IMC in distributed mode, see IMC deployment guides.

**Platform Specific Issues**

**Windows - General Issues**

- Please be especially careful about how filenames are capitalized and used. This is essential in order to ensure consistent behavior across platforms that might use case-sensitive file systems.
Linux - General Issues

- The IMC server must be run from a root user account in order to receive SNMP traps, accept syslog messages, and facilitate ftp file transfers.
- UNIX filenames are case sensitive. Care must be taken when references are made to python scripts and xml files.

Port Usage

IMC uses the following TCP/IP ports.
<table>
<thead>
<tr>
<th>Component</th>
<th>Subcomponent</th>
<th>Protocol</th>
<th>Port</th>
<th>Configurable</th>
<th>Use</th>
<th>Server</th>
<th>Client</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMC</td>
<td>-</td>
<td>TCP</td>
<td>8025</td>
<td>No</td>
<td>Used by the jserver process to receive the SHUTDOWN command.</td>
<td>IMC master server.</td>
<td>IMC master server.</td>
<td>Internal use.</td>
</tr>
<tr>
<td>IMC</td>
<td>-</td>
<td>TCP</td>
<td>9091</td>
<td>No</td>
<td>JMX monitoring port used by the jserver process.</td>
<td>IMC master server.</td>
<td>IMC master server.</td>
<td>Internal use.</td>
</tr>
<tr>
<td>IMC</td>
<td>-</td>
<td>TCP</td>
<td>9044</td>
<td>No</td>
<td>Used by the HPE IMC Server service to receive the SHUTDOWN command.</td>
<td>IMC master and subordinate servers.</td>
<td>IMC master and subordinate servers.</td>
<td>Internal use.</td>
</tr>
<tr>
<td>IMC</td>
<td>-</td>
<td>TCP</td>
<td>9055</td>
<td>No</td>
<td>Used by the Deployment Monitoring Agent process to receive the SHUTDOWN command.</td>
<td>IMC master and subordinate servers.</td>
<td>IMC master and subordinate servers.</td>
<td>Internal use.</td>
</tr>
<tr>
<td>IMC</td>
<td>-</td>
<td>TCP</td>
<td>61616</td>
<td>No</td>
<td>Used for communication in a distributed deployment environment.</td>
<td>IMC master and subordinate servers.</td>
<td>IMC master and subordinate servers.</td>
<td>Internal use.</td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Service</td>
<td>Protocol</td>
<td>Port</td>
<td>Use</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>----------</td>
<td>------</td>
<td>----------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>TCP</td>
<td>61626</td>
<td>Used for communication between the HPE IMC Server and Deployment Monitoring Agent processes.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Management</td>
<td>UDP</td>
<td>161</td>
<td>Used to access network devices through SNMP.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Management</td>
<td>UDP</td>
<td>162</td>
<td>Used to receive IMC SNMP Traps from network devices.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Management</td>
<td>TCP</td>
<td>22</td>
<td>SSH/SFTP port, which the configuration center uses to back up and restore the device software and configuration file through SSH/SFTP.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ICC</td>
<td>ICC</td>
<td>TCP</td>
<td>20/21</td>
<td>FTP port, which the configuration center uses to back up and restore the device software and configuration file through FTP.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Resource Management</td>
<td>Protocol</td>
<td>Port</td>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------</td>
<td>----------</td>
<td>------</td>
<td>--------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>ACL Management</td>
<td>TCP</td>
<td>23</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Alarm Management</td>
<td>TCP</td>
<td>25</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Resource Management</td>
<td>ICMP</td>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Resource Management</td>
<td>UDP</td>
<td>69</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Resource Management</td>
<td>TCP</td>
<td>80</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Telnet port, which the resource management module, ACL management module, and configuration center use to access the device through Telnet.

SMTP port, which the resource management module uses to send alarms through email.

ICMP port, which the resource management module uses to discover devices and check the reachability of the devices.

IMC-specific tftp daemon. Used to launch the Web network management system of the device.
<table>
<thead>
<tr>
<th>IMC Platform</th>
<th>Service</th>
<th>Protocol</th>
<th>Port</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Resource Management</td>
<td>TCP</td>
<td>443</td>
<td>Yes</td>
<td>HTTPS port, which the virtual network management module uses to obtain VMware virtual network data in SSL.</td>
<td></td>
</tr>
<tr>
<td>Syslog Management</td>
<td>UDP</td>
<td>514/515</td>
<td>Yes</td>
<td>IMC-specific syslog daemon.</td>
<td></td>
</tr>
<tr>
<td>Resource Management</td>
<td>TCP/UDP</td>
<td>137</td>
<td>No</td>
<td>NetBIOS name resolution service port, used by the IMC resource management module and terminal access module.</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>TCP</td>
<td>8080</td>
<td>Yes</td>
<td>IMC-specific Web server for HTTP protocol, which can be changed during installation.</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>TCP</td>
<td>8443</td>
<td>Yes</td>
<td>IMC-specific Web server for HTTPS protocol, which can be changed during installation.</td>
<td></td>
</tr>
<tr>
<td>IMC Platform</td>
<td>Protocol</td>
<td>Port Range</td>
<td>Listening Status</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
<td>------------</td>
<td>------------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>TCP 8800</td>
<td>No</td>
<td>IMC messaging gateway listening port.</td>
<td>IMC master and subordinate servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP 21190-21199</td>
<td>No</td>
<td>Used for communication in HPE IMC Server, euplat and seplat.</td>
<td>IMC master and subordinate servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP 1433</td>
<td>Yes</td>
<td>SQL Server database listening port (on Windows only).</td>
<td>IMC master and subordinate servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP 3306</td>
<td>Yes</td>
<td>MySQL database listening port.</td>
<td>IMC master and subordinate servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP 1521</td>
<td>Yes</td>
<td>Oracle database listening port (on Linux only).</td>
<td>IMC master and subordinate servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP 2810</td>
<td>No</td>
<td>Used for communication in DBMan.</td>
<td>DBMan. Internal use.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** On Linux, you must run IMC with root privileges to bind TCP/IP ports 69, 162, and 514.

**Note:** IMC cannot be bound to TCP/IP ports 69, 162, and 514 if they are used by other SNMP, TFTP, or syslog applications.

**Note:** Make sure the firewall on each IMC server does not block programs javaw.exe and java.exe. The programs are located in directory `/common/jre/bin` (/common/jre/bin/java for Linux) of the IMC installation path.

[ Table of Contents ]
Memory Allocation

The amount of memory allocated to the IMC jserver can be adjusted by a script. The memory size should be tuned to make use of as much memory as required by your particular IMC server. Move to the "client\bin" (or "client/bin" on Linux OS) sub-directory of the original IMC installation directory (using the "cd" command), and use the setmem.bat (or setmem.sh on Linux OS) script.

For example, to allocate 1024 MB RAM, move to the "installation directory\client\bin" (or "installation directory/client/bin" on Linux OS) directory, and run the script:

```bash
setmem.bat 2048  (Windows OS)
setmem.sh 2048   (Linux OS)
```

The default and maximum memory that can be allocated to the IMC jserver is listed below:

<table>
<thead>
<tr>
<th>OS Type</th>
<th>Default allocatable memory</th>
<th>Maximum allocatable memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 64-bit</td>
<td>2048 MB</td>
<td>Depending on the physical memory</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>2048 MB</td>
<td>Depending on the physical memory</td>
</tr>
</tbody>
</table>

[ Table of Contents ]

Known Problems

Installation/Upgrade/Patch

- For a correct installation, the installation path can contain letters, digits, underlines, and spaces, but cannot contain other special characters.
- If the system installed with IMC has insufficient memory, java overflow might occur. To prevent this issue, install IMC in a 64-bit OS with sufficient memory.
- During IMC platform upgrade from 7.1 (E0303L07), the system might display a message that directory iMC/deploy/jdk should be deleted manually. If you see the message, perform the following steps:
  - Start Windows Task Manager.
  - On the Processes tab, click the View menu and select Select Columns. Select the Command Line column and click OK.
  - Select the process named javaw.exe and click End Process.
  - In the dialog box that displays the upgrade error message, click Retry.
- You must install the performance and alarm components in IMC PLAT 7.3 (E0506).
Other Problems

- Symptom: When you use HTTP to open the iMC page through a Chrome browser, the iMC page cannot be opened, and the browser prompts that "ERR_TOO_MANY_REDIRECTS, There were too many redirects."
- After IMC (windows edition) is upgraded to IMC PLAT 7.3 (E0504P04), the memory usage of the IMC service process becomes high.
- The endpoint Real-Time location feature depends on the topology connection relationship of the gateway device. Make sure the topology connection relationship of the gateway device is correct.
- If the performance module is not deployed, a page error occurs when a user logs in to IMC.
- If EIA and IMC PLAT are deployed in centralized mode, the IMC page cannot be opened after IMC runs for a period of time.
- When traps are queried by trap OID, the query results are displayed in the SNMPv2c format by default.
- If the SendSmsTrapContentType parameter has been set in the qvdm.conf configuration file in IMC PLAT 7.2, you must reset the parameter on the System > System Configuration > SMSC Settings > SMS Content Format Configuration page after IMC is upgraded to version 7.3.
- When you modify a trap definition, the corresponding trap to alarm rule is not modified synchronously.
- Auto forwarding recovered alarm configuration is added to IMC PLAT 7.3 (E0504P02). If you do not need this feature, select No for Auto Forwarding Recovered Alarm Configuration on the System > System Configuration > System Settings page.
- If the system is busy, the progress bar may be shown for a long time when you perform an operation.
- IMC does not support the PoE features of Comware V3 devices.
- Configuration Center does not support the software upgrade of IRF devices through SSH/SFTP.
- Configuration Center does not support the software upgrade of old IRF2 devices or a device with dual main boards.
- If you configure a link aggregation across different units of IRF/IRF2 devices, the layer 2 topology cannot display the links because the master device cannot collect complete information about links of the subordinate members. Ensure you configure link aggregations only on the master device.
- When you view the check result of a compliance check task, the system might display "Do you want to abort the script?" if the check result contains too many devices and policies. Click No to continue the operation.
- A prompt "Connection to the server disconnected. Check the connection and try again" is displayed after the realtime performance monitoring runs for a while. Ignore the message and click OK.
- If the device model is not correct for a third-party device, select System > Device Model to edit the setting.
- In an SNMP packet, the SNMP variables of the visible string type, the encoding mode must be GBK or ASCII.
• If you upgrade your IMC to IMC PLAT 7.3, make sure you upgrade all components after the upgrade package is installed. Otherwise, IMC cannot start.
• The device locations might change on the Google map topology in windows of different sizes or in full screen with different resolutions.
• Discontinue monitoring the VM performance indices when the VM migrated to other hypervisor.
• If you cannot open the Applet topology after upgrading Java to the latest version for the client, select Control Panel > Java > Security, and set the Security Level to Middle.
• When you execute the backup.bat(sh) script to back up IMC before upgrading IMC, only files are backed up, but the database is not backed up.
• In the dashboard, the realtime performance monitoring data for memory utilization is displayed for CPU utilization.
• In the converged topology, the status of a subview is always displayed as grey, which is displayed based on alarms of the highest level on the devices in the subview.
• The following problems occur to the 3D chassis in the data center: the added virtual devices and trays cannot be displayed; the device locations in the 3D chassis are incorrect; after you configure the chassis, the newly added devices can be displayed only after the 3D chassis is reloaded.
• In the Linux system, import device software fails when both IPv4 and IPv6 exist.
• If IP addresses on two different network segments are configured on the IMC server, the non-default initial configuration file fails to be downloaded when a device with zero configurations is automatically deployed.
• The SNMP test fails when the device location information is null.
• A user creates a view on the Flex-based display tiling page and adds performance trend widgets and widgets of other types for the view. The user configures no parameters for all widgets. The view displays the URL of the third-party control when the user accesses the view page for the first time. The URL of the third-party control disappears and the performance trend widgets become unavailable when the user accesses the view page for a second time.
• After VLAN interfaces are undeployed for tenants through RAM, the system prompts a configuration conflict if you deploy the same VLAN interfaces.
• When VLANs are deployed to a device, access interface configurations fail.
• After the Telnet or SSH parameters are modified for devices, the devices are not immediately synchronized in the ACL manager.
• A Cisco low-end switch is added to the IMC platform with the SSH access method, Password authentication mode, and an empty password field. When an operator syncs or tests connectivity to the switch, the memory usage of the resource background process soars in seconds and the process eventually crashes.
• Some of the E1POS interfaces of a device are not displayed on the device interface list, which is accessed by selecting POS Access > Interfaces on the device details page.
• When a user logs on to IMC with the browser in windowed mode and then maximizes the browser, the page size cannot be adjusted. To solve this problem, refresh the page.
• After the BIMS component is deployed on IMC, the V2 report still cannot be viewed. To solve this problem, delete the castor-0.9.9.1.jar in iMC\client\repository\castor\jars\ folder, and copy the castor-1.2.jar from iMC\client\web\apps\rptviewer\WEB-INF\lib\ folder to the iMC\client\repository\castor\jars\ folder.
• Chrome42+ disables NPAPI, including JRE. Because of this, IMC cannot open applet when using Chrome 42+.
• There are more than 20 devices in a filter rule, fail to add the Syslog filter rule.
• Add monitor again after the VM migrated to other hypervisor, discontinue monitoring the VM performance indices when the VM migrated to other hypervisor.
• This symptom occurs when use the converged topology feature. In the converged topology, the status of a subview is always displayed as grey, which is displayed based on alarms of the highest level on the devices in the subview.
• Open data center topology, The following problems occur to the 3D chassis in the data center: the added virtual devices and trays cannot be displayed; the device locations in the 3D chassis are incorrect; after you configure the chassis, the newly added devices can be displayed only after the 3D chassis is reloaded.
• This symptom occurs when IP addresses on two different network segments are configured on the IMC server. The non-default initial configuration file fails to be downloaded when a device with zero configurations is automatically deployed.
• An operator frequently switches between floors of a room, On a room topology, frequent switches between floors cause the windows and doors to display incorrectly.
• A user creates a view on the Flex-based display tiling page and adds performance trend widgets and widgets of other types for the view. The user configures no parameters for all widgets. The view displays the URL of the third-party control when the user accesses the view page for the first time. The URL of the third-party control disappears and the performance trend widgets are unavailable when the user accesses the view page for the second time.
• This symptom occurs if the target device is not synchronized after VLAN interfaces are undeployed. After VLAN interfaces are undeployed for tenants through RAM, the system prompts a configuration conflict if you deploy the same VLAN interfaces.
• This symptom occurs if the Layer 2 aggregate interface configuration changes made in the VLAN manager are not synchronized to devices. When VLANs are deployed to a device, access interface configurations fail.
• This symptom occurs when the Telnet or SSH parameters are modified for devices. After the Telnet or SSH parameters are modified for devices, the devices are not immediately synchronized in the ACL manager.
• A Cisco low-end switch is added to the IMC platform with the SSH access method, Password authentication mode, and an empty password field. An operator tests connectivity to the switch, or sync the device to IMC platform. When an operator syncs or tests connectivity to a newly added Cisco low-end switch, the memory usage of the resource background process soars in seconds and the process eventually crashes.
• An operator accesses the POS Access > Interfaces page from the device details page. Some of the E1POS interfaces of a device are not displayed on the device interface list page.
• This symptom occurs when the CAS version is earlier than E0209. No data is collected when VRM monitors CAS.
• On the custom topology, device labels are modified to Korean character strings, and they become illegible after the topology is reloaded.
• The default background of the H3C Web desktop edition is changed to the HPE image.
• In HPE RSM edition, the HPE logo is not aligned to the upper-left corner on the login page.
• The topology does not support displaying complete distributed trunk links for HPE switches.
• Traps cannot be received when the trap OID exceed 128 characters or the trap packet exceeds 4096 bytes.
• When the SNMP packet maximum size on a device is set to a value greater than 4096, SNMP packets from the device cannot be parsed.
• In a non-English operating system, you must modify the language to English (United States) in the Control Panel > Region and Language window. Then, click Copy settings in the Administrative tab, and select Welcome screen and system accounts and New user accounts.
• In an English operation system, you must use the default language format in the Control Panel > Region and Language window.
• The Axis2(CVE-2010-1632) vulnerability exists. To solve this problem, manually delete the folder iMC\client\web\apps\imcws.
• After Java 8 is installed, a security warning dialog box displaying that the publisher is unknown appears when you click SSH on device Action list. To solve this problem, manually import the iMC\client\security\newksp12.p12 certificate file into the Signer CA certificate of jdk.
• If you select multi-level view for the Syslog upgrade rule, the device Syslogs cannot be upgraded to alarms according to the upgrade rule.
• If the value format is not ,. for the Oracle database client character set, the performance threshold cannot be modified.
• The display on the page is inconsistent with the actual deployment information if the subcomponents that do not stop the master server process (for example, APME) are updated or deployed on the subordinate server.
• The custom view data summary reports V2 created before the upgrade will be lost after the IMC platform is upgraded to IMC PLAT 7.3 (E0503).
• After IMC is upgraded, clear the cache of the browser to get the optimal access experience.
• When you configure SNMPv3 to send traps or informs to IMC, set the engine ID to 800063A2800123456789ABCDEF0123.
• The topology cannot be displayed and operated on touch screens.
• When IMC has ever upgraded to IMC PLAT 7.2 (E0403P02), IMC PLAT 7.2 (E0403P03), or IMC PLAT 7.2 (E0403P06), jserver cannot start after the iCC component is uninstalled.
• When IMC is upgraded from versions earlier than IMC PLAT 7.2 (E0403P10), the system prompts "Checking the installation environment failed."
• When IMC is upgraded to IMC PLAT 7.3 (E0506) in Windows, the memory usage of the dma and dms processes increases.
• The operator cannot be assigned privilege to part of user groups and the number of user groups cannot be larger than 2000.
• After modifying the database password, you must click the Environment tab on the Intelligent Deployment Monitoring Agent, and click Change Password to change the password synchronously on the dialog box that opens. Then, you must click Configure in
the Database Backup and Restore area, and click OK on the Auto Backup and Recovery Settings dialog box that opens.

- The Tomcat service might exit exceptionally with a low probability if the topology, 3D room, and dashboard functions are used for a long time.
- If a large number of widgets exist on the homepage, a certain widget might be blank and prompt that "Please wait" when the homepage is opened.
- The NullPointerException errors might occur on the At a glance page if you query the detailed performance data of interface traffic for the first time within the custom time range.
- The topology is not available in tablet model. To use the topology on a touch-screen endpoint, disable the tablet model and use a mouse.
- Adding devices to the rack topology fails if IMC is running in the Linux + Oracle environment. To solve this problem, manually perform the following storage process in the database:

```sql
declare columnDThreeExistedCount number;
begin
select count(1) into columnDThreeExistedCount from all_tab_cols t where t.table_name = upper('tbl_d3topo_deviceinfo') and t.column_name=upper('decribe');
if columnDThreeExistedCount = 0 then
execute immediate
'ALTER TABLE tbl_d3topo_deviceinfo ADD decribe varchar(1024)';
end if;
end;
```

- In hierarchical NMS, the lower-level NMS performance view of the dashboard cannot obtain the performance view of the lower-level system if the username and password of the current user are used when the lower-level NMS system is added.
- For hierarchical IMC to operate correctly, please first upgrade the lower-level IMC and then upgrade the upper-level IMC, or restart the upper-level IMC after upgrading the lower-level IMC.
- In an active/standby IMC server scenario, please copy the $iMC/common/conf/ks.dat and $iMC/server/conf/imchw.conf files in the IMC installation directory on the active IMC server to the corresponding directories on all standby IMC servers. After copying these files, restart the IMC service to make these files take effect. If a standby IMC server is deployed with a separate database and the deployment monitoring agent is not installed on the database server, please copy the two files to the $iMC/dbman/etc/ directory of the database server.
- After message push is enabled on the Task Management > Message Options page, some pages in IMC cannot operate correctly.
- After you upgrade IMC, clear the browser cache before logging in to IMC.
- An upper-level IMC system supports a maximum of 10 lower-level IMC systems, and each lower-level IMC system can manage a maximum of 5000 devices.
- The operator password cannot exceed 32 characters. In RADIUS, LDAP, or TACACS authentication, the user password on the authentication server cannot exceed 32 characters.
- If WSM is upgraded from IMC WSM 7.2 (E0502) or earlier, the WSM-related processes still exist after the WSM component is uninstalled.
• When a Window server with IMC installed is restarted, shut down, or logged off, the intelligent deployment monitoring agent must be ended through the ending program window if many service components are deployed.
• When a component is upgraded, the intelligent deployment monitoring agent prompts that "Checking the installation environment failed." if many service components are deployed and the component upgraded has many history versions.
• When the operating system is started, make sure the database is started before IMC.
• When the public components are updated in Windows, the system prompts that JDK upgrade fails. To solve this problem, manually stop the DHCP Client and Windows Event Log services for Windows, and then upgrade IMC.
• The operating system time must be the same on the master and subordinate servers.
• When use HTTPS to access IMC on a Chrome browser of certain versions, the homepage might be opened very slowly. This problem is caused by the Chrome browser. To avoid this problem, use the latest Firefox or IE browser.
• IMC fails to access some Huawei devices by using SSHv2. To solve this problem, use the undo ssh server authentication-type keyboard-interactive enable command on the devices to disable keyboard-interactive and then save the configuration.
• The 64-bit Firefox does not support NPAPI plugins (including JAVA), and support for NPAPI plugins is disabled in Firefox 52 and later. To access IMC features correctly through Firefox, use 32-bit Firefox of a version earlier than Firefox 52 or use Firefox ESR of a version later than Firefox 52. The operating system on which Firefox runs must have the 32-bit JAVA plugin installed.
• When there is a large amount of data in the generated performance report, the data on the horizontal axis and vertical axis might be very dense.
• The performance component must be installed.
• An upper-level NMS cannot view the server resources of a lower-level NMS if there is a GAP between the upper-level NMS and lower-level NMS.
• Exceptions occur in the Web manager, refresh, and server events if you execute the actions and configurations in the right pane of the server details page.
• For hierarchical IMC to operate correctly, please first restart upper-level IMC when restarting all the IMC's.
• When you click Expand All and Collapse All multiple times, the page responds slowly.
• Typically, 200,000 or less items of data can be exported successfully. Exporting too many data might fail.
• When the SQL Browser service is not started, some IMC processes might fail to start properly.